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Introduction

The book is based on many years’ experience in reading AutoCAD courses for
students of various specialties. The educational material is designed for any version
of the program, starting with AutoCAD 2008.

Now, there are many graphic editors and geometric modeling programs.
Autodesk is one of the leading manufacturers of computer-aided design systems and
software for designers and architects. It is the world’s largest provider of software
and services for industrial and civil engineering, geoinformatics, digital media and
wireless communications, serving 7 million users.

The AutoCAD system developed by this company is the world’s leading
software platform for computer-aided design (CAD) systems for professionals who
need to transform their creative ideas into real dynamic projects.

AutoCAD is a program with a rich and unique history. For the first time it was
published in 1982 under the name MicroCAD. The first version of AutoCAD marked
the beginning of a real revolution in computer-aided design. Today AutoCAD is
translated into 18 languages, it is used by millions of designers around the world on
processors which are thousands times more powerful than those that were installed on
the first personal computers.

AutoCAD is a constantly evolving basic design environment, each new version
of which inherits the best ideas of previous ones and affords solving the following
main tasks:

e users’ productivity and effectiveness increase ;

¢ the existing developments repeated usage;

e users’ unhindered cooperation in the design;

AutoCAD adaptation to the individual needs of object-oriented tasks
developers.

Autodesk key to the success is the worldwide recognition of AutoCAD as a de
facto standard for products and components development as well as for
documentation.

Using the strategy to help customers in creating, organizing, distributing digital
design data and serious business problems solving, Autodesk offers the most
complete integrated software tools set for 2D and 3D design, which allows to create
better products, accelerate their delivery to the market, achieve maximum projects
visibility and the most effective cooperation.



Chapter 1
Launching AutoCAD. AutoCAD files and
folders

Operations with AutoCAD Drawings

A quick way to begin a new drawing is to start from scratch, which starts a
drawing that uses settings from a default drawing template file.

You can start from scratch from the Create New Drawing dialog box, from the
Select Template dialog box, or without using a dialog box at all. In each case, you use
either the NEW command or the QNEW command.

Create New Drawing Dialog Box

The following conditions must be met to display the Create New Drawing
dialog box:

e The STARTUP system variable is set to 1 (on);

e The FILEDIA system variable is set to 1 (on).

The dialog box defines the settings for a new drawing. Start from Scratch
creates a new drawing using either imperial or metric default settings. Use a
Template creates a new drawing using the settings defined in a drawing template you
select. Use a Wizard creates a new drawing using the settings you specify in either
the Quick or Advanced wizard. (The first option, Open a Drawing, is not available
from the NEW command. To open an existing drawing, use OPEN)).

— Start from Scratch

]

Starts an empty drawing using default imperial or metric settings
(MEASUREINIT system variable). You can change the measurement system for a
given drawing by using the MEASUREMENT system variable. The Drawingl.dwg
that opens when you start the program is a drawing that is started from scratch.

Imperial

Starts a new drawing based on the imperial measurement system. The default
drawing boundary (the grid limits) is 12 by 9 inches.

Metric

Starts a new drawing based on the metric measurement system. The default
drawing boundary (the grid limits) is 429 by 297 millimeters.

Tip

Displays a description of the selected measurement setting.




— Use a Template

Starts a drawing based on a drawing template file. Template drawings store all
the settings for a drawing and may also include predefined layers, dimension styles,
and views. Template drawings are distinguished from other drawing files by the .dwt
file extension. They are normally kept in the template directory.

Several template drawings are included with this program. You can make
additional template drawings by changing the extensions of drawing file names
to .dwt.

Select a Template

Lists all DWT files that currently exist in the drawing template file location,
which is specified in the Options dialog box. Select a file to use as a starting point for
your new drawing.

Preview

Displays a preview image of the selected file.

Browse

Displays the Select a Template File dialog box (a standard file selection dialog
box), where you can access template files that are not available in the Select a
Template list.

Template Description

Displays a description of the selected template. If you create your own
template, you can use the Template Options dialog box to specify the text that you
want to display here. See the SAVEAS command.

& — Use a Wizard

Sets up a drawing using a step-by-step guide. You can choose from two
wizards: Quick Setup and Advanced Setup.

Quick Setup

Displays the Quick Setup wizard, in which you can specify the units and area
for your new drawing. The Quick Setup wizard also changes settings, such as text
height and snap spacing, to an appropriate scale.

Advanced Setup

Displays the Advanced Setup wizard, in which you can specify the units, angle,
angle measure, angle direction, and area for your new drawing. The Advanced Setup
wizard also changes settings, such as text height and snap spacing, to an appropriate
scale.

Wizard Description

Displays a description of the selected wizard.

Standard File Selection Dialog Boxes

Several commands display standard file selection dialog boxes, in which you
can navigate through local and network drives and through FTP sites and Web folders
to select files.



While each dialog box may vary slightly, following is a list of the possible
options:

1. Places List. Provides quick access to predefined locations. You can reorder
the icons in the Places list by dragging them to a new position. To add a new icon to
Places, drag a folder from the list. Right-click in Places to display a shortcut menu
with options for adding, removing, and modifying icons or restoring default icons
that have been removed. Changes to Places affect all standard file selection dialog
boxes.

e History. Displays shortcuts to the files most recently accessed from the
dialog box (fig.1.1). It is recommended that you periodically remove unwanted
shortcuts from the History list. Select History, then select the unwanted shortcuts in
the Files list and click Delete. To sort the shortcuts by date, click Views Details, and
then click the Modified column in the Files list.
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Figure 1.1 — Select file window

e Personal/My Documents. Displays the contents of the Personal or My
Documents folder for the current user profile. The name of this location («Personal»
or «My Documents») depends on your operating system version.

e Favorites. Displays the contents of the Favorites folder for the current user
profile. This folder consists of shortcuts to files or folders that you added to Favorites
using the Tools Add to Favorites option in the dialog box.

e FTP. Displays the FTP sites that are available for browsing in the standard
file selection dialog box. To add FTP locations to this list, or to modify an existing
FTP location, click Tools Add/Modify FTP Locations in the dialog box.



e Desktop. Displays the contents of your desktop.

e Buzzsaw. Provides access to Buzzsaw projects. Buzzsaw is a secure
Internet-based collaboration and project management service that connects project
teams in different locations. To use Buzzsaw, you must already have a project hosting
account on Buzzsaw or be given access to a subscriber’s Buzzsaw site. If you do not
yet have a project hosting account on Buzzsaw, clicking Buzzsaw displays the Select
Template dialog box where you can add a Buzzsaw location shortcut. Double-
clicking Add a Buzzsaw Location Shortcut opens the Log In To Buzzsaw dialog box
where you can register for a free 30-day trial subscription to the service. Also, the
first time you access Buzzsaw, your default web browser opens with the project
hosting page displayed. If you already have a project hosting account, clicking
Buzzsaw shows all of your project sites in the Site list.

2. Look In/Save In. Displays the current folder or drive. Click the arrow to
view the hierarchy of the folder path and to navigate up the path tree or to other
drives, network connections, FTP locations, or web folders (either Web Folders or
My Network Places, depending on the version of your operating system). You can
create web folders in Windows Explorer. Consult your system administrator or
Windows Explorer Help for more information about web folders. To control whether
the last used paths in each particular standard file selection dialog box are stored
across sessions, use the REMEMBERFOLDERS system variable.

3. Back. Returns to the previous file location.

4. Up One Level. Navigates one level up in the current path tree.

5. Search the Web. Displays the Browse the Web dialog box, from which you
can access and store files on the Internet.

6. Delete. Deletes the selected file or folder.

7. Create New Folder. Creates a new folder in the current path using a name
that you specify.

8. Views. Controls the appearance of the Files list or Folders list and, for a
Files list, specifies whether to show a preview image when a file is selected.

e List. Displays a multicolumn list.

¢ Details. Displays a single-column list with file details.

e Preview. Displays a bitmap of the selected file. The Preview area is blank if
you do not select a file. To save a bitmap with a drawing file, use the Save a
Thumbnail Preview Image option on the Open and Save tab in the Options dialog
box.

9. Tools. Provides tools to help with file selection and other actions available
in file selection dialog boxes.

e Find. Displays the Find dialog box, in which you can search for files using
name, location, and date-modified filters.

e Locate. Uses the AutoCAD search path to locate the file specified in File
Name. You set the search path on the Files tab in the Options dialog box.

e Add/Modify FTP Locations. Displays the Add/Modify FTP Locations
dialog box, in which you can specify the FTP sites to make available for browsing.
To browse these sites, select FTP from the Places list.



e Add Current Folder to Places. Adds an icon for the selected folder to the
Places list, providing quick access to that folder from all standard file selection dialog
boxes. To remove the icon, right-click the icon and choose Remove.

e Add to Favorites. Creates a shortcut to the current Look In location, or to
the selected file or folder. The shortcut is placed in the Favorites folder for the current
user profile, which you can access by choosing Favorites in the Places list.

¢ Look in Favorites. Sets the Look In path to your system’s Favorites folder.

e Options. Provides additional options for certain standard file selection
dialog boxes.

e Security Options. Provides options for a digital signature and password that
are invoked when you save a file.

10. Files List. Displays the files and folders in the current path and of the
selected file type. Use the Views menu in the dialog box to switch between List view
and Details view.

11. Preview. Displays a bitmap of the selected file when you choose Views
Preview in the dialog box. The Preview area is blank if you do not select a file. To
save a bitmap with a drawing file, use the Save a Thumbnail Preview Image option
on the Open and Save tab in the Options dialog box.

12. File Name. Displays the name of the file you select in the Files list. If you
select multiple files, File Name displays each selected file within quotation marks. If
you enter a file name in the File Name box, any selection is cleared. You must use
quotation marks when entering multiple file names. You can use wild-card characters
to filter files displayed in the Files list.

13. Files of Type. Filters the list of files by file type. When you are saving
files, Files of Type specifies the format in which the file is saved.

14. Select Initial View. Displays the specified model space view when you
open the drawing if the drawing contains more than one named view.

15. Update Sheet and View Thumbnails Now. Reflects the current setting of
the UPDATETHUMBNALIL system variable. This option temporarily overrides that
setting. Clear the checkbox to save the file without updating thumbnails. Check the
box to update all thumbnails. This option does not change the current setting of
UPDATETHUMBNAIL.

16. Open/Save. Depending on the purpose of the specific file selection dialog
box, opens or saves the selected file or enters the path of the selected folder in the
previous dialog box. Certain file selection dialog boxes may include additional
options, accessed by clicking the arrow next to the Open button.

e Open Read-Only. Opens a file in read-only mode. You cannot save changes
to the file using the original file name.

e Partial Open. Displays the Partial Open dialog box. You can open and load
a portion of a drawing, including geometry on a specific view or layer.
PARTIALOPEN cannot be used with a drawing that is not in the latest drawing file
format.

e Partial Open Read-Only. Opens the specified drawing portions in read-
only mode.



Partial Open Dialog Box

The dialog box displays the drawing views and layers available for specifying
what geometry to load into the selected drawing (fig. 1.2). When working with large
drawing files, you can select the minimal amount of geometry you need to load when

opening a drawing.
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Figure 1.2 — Partial Open window

When a drawing is partially open, all named objects, as well as the specified
geometry, are loaded into the file. Named objects include blocks, dimension styles,
layers, layouts, linetypes, text styles, UCSs, views, and viewport configurations.

Save AutoCAD Drawings

You save drawing files for later use just as you do with other Microsoft
Windows applications. You can also set up automatic saving and backup files and
save only selected objects.

When you work on a drawing, you should save it frequently. Saving protects
you from losing work in the event of a power failure or other unexpected event. If
you want to create a new version of a drawing without affecting the original drawing,
you can save it under another name.

The file extension for drawing files is .dwg, and unless you change the default
file format in which drawings are saved, drawings are saved in the latest drawing file
format. This format is optimized for file compression and for use on a network.
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The character limit for a DWG file name (including its path) is 256 characters.

If FILEDIA is set to 1 the Save Drawing As standard file selection dialog box
is displayed. When FILEDIA is set to 0, SAVEAS displays command prompts.

Enter a file name and type.

Note. AutoCAD 2004 is the drawing file format used by the AutoCAD 2004,
AutoCAD 2005, and AutoCAD 2006 releases.

In the Save Drawing As dialog box (fig. 1.3), Tools Options displays the
Saveas Options dialog box, which controls various DWG and DXF settings.

DWG Options Tab (Saveas Options Dialog Box) controls the drawing index
and display of custom objects and specifies the default file format for saving
drawings.

IE-E Saveas Options E]\

D'/ Options | O<F Options

Save proxy images of custom objects

[ndes pe: ' More |

Save all driawings as: .a'-‘-.utnlf.i'-.D 2007 Drawing [*. dwg) -v.

[ ] ][ Cancel ][ Help ]

Figure 1.3 — Save as Option window

Save Proxy Images of Custom Objects

If you save to an earlier drawing file type, or the drawing contains custom
objects from another application, you can select Save Proxy Images of Custom
Objects to save images of the custom objects in the drawing file. If you do not choose
this option, a frame is saved for each custom object in the drawing file.
(PROXYGRAPHICS system variable). If you are saving a drawing file that contains
DWF references to an earlier drawing format, this switch has no effect on DWF
underlays as they will not appear as proxy objects or as a frame.

Index Type

Determines whether layer or spatial indexes are created when you save a
drawing. The indexes are used to improve performance during demand loading.
Using indexes may slightly increase the time required to save a drawing. If a partially
open drawing does not already contain spatial and layer indexes, this option is not
available

The file is saved with the specified file name. If the drawing is already named,
the drawing is saved with the new file name. If you save the file as a drawing
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template, the Template Options dialog box is displayed, where you can provide a
description for the template and set the units of measurement.
Template Options Dialog Box (fig. 1.4) sets drawing template options.

-

3 Template Options
Clescription
ak.
| [ oc |
Measurement
Englizh v

MHew Layer Motification
(#) Save all lavers as unreconciled

() Save all layers az reconciled

Figure 1.4 — Template Options Dialog Box

Practical work

Purpose: acquiring skills of work with disks, folders and files (documents)
in AutoCAD

Work order:

1. Create a folder with the same name as the name of your group in «My
documentsy folder.

2. Create a personal folder, the folder name is your surname (use the English
alphabet), in this folder.
3. Open AutoCAD.
4. Create 4 drawings in AutoCAD and save them in your personal folder
(the surname is written in the English alphabet):
o surname risl.dwg
o surname ris2.dwg
o surname ris3.dwg
o surname ris4.dwg
5. Exit AutoCAD.
6. Open AutoCAD.

7. Open all these 4 drawings created before and locate them with the «Arrange
Icons» in the Window menu.

12



8. In every drawing, draw a picture using the lines, circles and arcs drawing
commands.

9. Save all the drawings.

10. Compress all the drawings in the same archive folder.

11. Save this archive in the Academy distance learning system.

Basic theoretical information

Operations with AutoCAD Drawings

A quick way to begin a new drawing is to start from scratch, which starts a
drawing that uses settings from a default drawing template file.

You can start from scratch from the Create New Drawing dialog box, from the
Select Template dialog box, or without using a dialog box at all. In each case, you use
either the NEW command or the QNEW command.

Create New Drawing Dialog Box

The dialog box defines the settings for a new drawing. Start from Scratch
creates a new drawing using either imperial or metric default settings. Use a
Template creates a new drawing using the settings defined in a drawing template you
select. Use a Wizard creates a new drawing using the settings you specify in either
the Quick or Advanced wizard. (The first option, Open a Drawing, is not available
from the NEW command. To open an existing drawing, use OPEN.)

Standard File Selection Dialog Boxes

Several commands display standard file selection dialog boxes, in which you
can navigate through local and network drives and through FTP sites and Web folders
to select files. While each dialog box may vary slightly, following is a list of the
possible options.

Partial Open Dialog Box

The dialog box displays the drawing views and layers available for specifying
what geometry to load into the selected drawing. When working with large drawing
files, you can select the minimal amount of geometry you need to load when opening
a drawing.

When a drawing is partially open, all named objects, as well as the specified
geometry, are loaded into the file. Named objects include blocks, dimension styles,
layers, layouts, linetypes, text styles, UCSs, views, and viewport configurations.

Save AutoCAD Drawings

You save drawing files for later use just as you do with other Microsoft
Windows applications. You can also set up automatic saving and backup files and
save only selected objects.

When you work on a drawing, you should save it frequently. Saving protects
you from losing work in the event of a power failure or other unexpected event. If

13



you want to create a new version of a drawing without affecting the original drawing,
you can save it under another name.

The file extension for drawing files is .dwg, and unless you change the default
file format in which drawings are saved, drawings are saved in the latest drawing file
format. This format is optimized for file compression and for use on a network.

The character limit for a DWG file name (including its path) is 256 characters.

If FILEDIA is set to 1 the Save Drawing As standard file selection dialog box
is displayed. When FILEDIA is set to 0, SAVEAS displays command prompts.

Note. AutoCAD 2004 is the drawing file format used by the AutoCAD 2004,
AutoCAD 2005, and AutoCAD 2006 releases.

In the Save Drawing As dialog box, Tools Options displays the Saveas Options
dialog box, which controls various DWG and DXF settings.

DWG Options Tab (Saveas Options Dialog Box) controls the drawing index
and display of custom objects and specifies the default file format for saving
drawings.

Self-examination questions

. What is AutoCAD?
. The purpose, functions, capabilities and scope of AutoCAD.
. Organization of the AutoCAD working window.
. How to adjust the boundaries of the drawing?
. How can I set the required line types?
. What are the snap and grid used for?

. Basic principles of working with layers. What are they needed for? How do I
set the line type and color of the image in the layer?

8. What is a drawing template? How to create a template? How to create a new

drawing based on an existing template?

\]O'\Ul-lkwl\)’—
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Chapter 2
AutoCAD interface. Commands input
methods, the use of menus and tool bars. Work
with layers. Points coordinates input methods

The User Interface

You can use several menus, shortcut menus, toolbars, and the dashboard to
access frequently used commands, settings, and modes.

Toolbars

Use buttons on toolbars to start commands, display flyout toolbars, and display
tooltips. You can display or hide, dock, and resize toolbars.

Toolbars contain buttons that start commands. When you move your mouse or
pointing device over a toolbar button, the tooltip displays the name of the button.
Buttons with a small black triangle in the lower-right corner are flyout toolbars that
contain related commands. With the cursor over the icon, hold down the left button
on your mouse until the flyout toolbar is displayed.

The Standard toolbar at the top of the drawing area is displayed by default.
This toolbar is similar to those found in Microsoft Office programs. It contains
frequently used AutoCAD commands such as PROPERTIES, PAN, and ZOOM, as
well as Microsoft Office standard commands such as New, Open, and Save.

Display or Hide, Dock, and Resize Toolbars. AutoCAD initially displays
several toolbars such as

e Standard toolbar
e Styles toolbar
e Layers toolbar

You can display or hide these toolbars and additional ones, and you can save
your selections as a workspace. You can also create your own toolbars.

A toolbar can be floating or docked. A floating toolbar is located anywhere in
the drawing area, and you can drag a floating toolbar to a new location, resize it, or
dock it. A docked toolbar is attached to any edge of the drawing area. You can move
a docked toolbar by dragging it to a new docking location.

Status Bars

The application and drawing status bars provide useful information, buttons for
turning on and off drawing tools.

15



The application status bar displays the coordinate values of your cursor along with
several buttons for turning on and off drawing tools and may display tools for scaling
annotations. You can choose which buttons you want to display in the status bar.

[ l55384, 13870, 00000 | snaP GRID| ORTHO [POLAR [DSNAP [OTRACK [DUCS [DYN LwT [MODEL Arvotation Seale: 11+ & 4 gp [ |

The drawing status bar displays several tools for scaling annotations.

Different tools display for model space and paper space.

When the drawing status bar (fig. 2.1) is turned on it displays at the bottom of
the drawing area. When the drawing status bar is turned off, the tools found on the
drawing status bar are moved to the application status bar.

When the drawing status bar is turned on, you can use the Infobar menu to
choose which tools display in status bar.
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Figure 2.1 — Status bar
The Menu Bar

Display pull-down menus from the menu bar using one of several methods.
You can also specify alternate menus.

Menus are available from the menu bar at the top of the AutoCAD drawing
area.

To use a menu choose one of the following methods:

e On the menu bar, click a menu name to display a list of options. On the
menu, either click an option or use the DOWN ARROW to move down the list, and
then press ENTER;
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e Press ALT and press the key for the underlined letter in the menu name;
then, press the underlined letter in the option name. For example, to open a new
drawing, press ALT and press F to open the File menu; then, press N for New.

You can specify menus to display in the program by customizing a CUI file
and loading it into the program.

Shortcut Menus

Display a shortcut menu for quick access to commands that are relevant to your
current activity.
You can display different shortcut menus when you right-click different areas
of the screen, including:
e Within the drawing area with or without any objects selected,
Within the drawing area during a command,
Within the text and command windows,
Within areas and on icons in DesignCenter,
Within areas and on text in the In-Place Text Editor,
On a toolbar or tool palette,
On the Model or layout tabs,
On the status bar or the status bar buttons,
In certain dialog boxes.
Shortcut menus typically include options to:
e Repeat the last command entered,
e (Cancel the current command,
e Display a list of recent user input,
Cut, copy, and paste from the Clipboard,
Select a different command option,
Display a dialog box, such as Options or Customize,
Undo the last command entered.
You can customize right-click behavior to be time-sensitive, so that a quick
right-click acts the same as pressing ENTER, and a longer right-click displays a
shortcut menu.

Shortcut menus can be customized using a customization (CUI) file. The main
CUI file is called acad.cui by default.

The Dashboard

The dashboard is a special palette that displays buttons and controls that are
associated with a task-based workspace.

The dashboard provides a single interface element for operations that are
relevant to the current workspace. The dashboard eliminates the need to display a lot
of toolbars and reduces the clutter in the application window. Thus, you can
maximize the area available for work, and use a single interface for speed and
convenience.
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The dashboard opens automatically by default when you use either the 2D
Drafting & Annotation workspace or the 3D Modeling workspace. You can open the
dashboard manually:

e Click Tools menu » Palettes » Dashboard;

e At the Command prompt, enter dashboard.

The dashboard is organized into a series of control panels. Each control panel
includes related tools and controls that are similar to the tools in toolbars and controls
in dialog boxes.

The large icons displayed at the left side of the dashboard are called control
panel icons. Each control panel icon identifies the purpose of the control panel. On
some control panels, if you click the icon, a slide-out panel opens that contains
additional tools and controls. An open slide-out panel closes automatically when you
click another control panel icon. Only one slide-out panel is displayed at a time.

A tool palette group can be associated with each control panel. To display the
associated tool palette group, click a tool or open a slide-out panel.

You can customize the display of the dashboard (display or hide, dock, and
resize the dashboard) in the following ways:

e Size the dashboard horizontally. If not enough space is available to display
all the tools in a row, a black down-arrow called an overflow control is displayed,

e Use the shortcut menu to control the auto-hide, docking, and anchoring
behavior. With anchoring, the dashboard results are displayed as a narrow space-
saving strip along the left or right edge of the drawing area.

You can customize the dashboard in the following ways:

e You can create and modify dashboard panels using the Customize User
Interface dialog box,

e You can specify which control panels are displayed by right-clicking the
dashboard and, on the shortcut menu, clicking or clearing the names of control
panels,

¢ You can associate a customizable tool palette group with each control panel
on the dashboard. Right-click the control panel to display a list of available tool
palette groups.

Enter Commands on the Command Line

You can enter a command by using the keyboard. Some commands also have
abbreviated names called command aliases.

To enter a command by using the keyboard, type the full command name on
the command line and press ENTER or SPACEBAR.

Note. When Dynamic Input is on and is set to display dynamic prompts, you
can enter many commands in tooltips near the cursor.

Some commands also have abbreviated names. For example, instead of
entering line to start the LINE command, you can enter l. Abbreviated command
names are called command aliases and are defined in the acad.pgp file.
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To find a command, you can type a letter on the command line and press TAB
to cycle through all the commands that begin with that letter. Press ENTER or
SPACEBAR. Restart a recently used command by right-clicking on the command
line.

When you enter commands on the command line, you see either a set of
options or a dialog box. For example, when you enter circle at the Command prompt,
the following prompt is displayed:

Specify center point for circle or [3P/2P/Ttr (tan, tan, radius)]:

You can specify the center point either by entering X,Y coordinate values or by
using the pointing device to click a point on the screen.

To choose a different option, enter the letters capitalized in one of the options
in the brackets. You can enter uppercase or lowercase letters. For example, to choose
the three-point option (3P), enter 3p.

To execute commands, press SPACEBAR or ENTER, or right-click your
pointing device after entering command names or responses to prompts. The
instructions in Help assume this step and do not specifically instruct you to press
ENTER after each entry.

If you want to repeat a command that you have just used, press ENTER or
SPACEBAR, or right-click your pointing device at the Command prompt.

You also can repeat a command by entering multiple, a space, and the
command name, as shown in the following example:

Command: multiple circle

To cancel a command in progress, press ESC.

Many commands can be used transparently: that is, they can be entered on the
command line while you use another command. Transparent commands frequently
change drawing settings or display options, for example, GRID or ZOOM. In the
Command Reference, transparent commands are designated by an apostrophe in front
of the command name.

To use a command transparently, click its toolbar button or enter an apostrophe
(‘) before entering the command at any prompt. On the command line, double angle
brackets (>>) precede prompts that are displayed for transparent commands. After
you complete the transparent command, the original command resumes. In the
following example, you turn on the dot grid and set it to one-unit intervals while you
draw a line, and then you continue drawing the line:

Command: line

Specify first point.: ‘grid

>>Specify grid spacing (X) or [ON/OFF/Snap/Aspect] <0.000>: 1
Resuming LINE command

Specify first point:

Commands that do not select objects create new objects, or end the drawing
session usually can be used transparently. Changes made in dialog boxes that you
have opened transparently cannot take effect until the interrupted command has been
executed. Similarly, if you reset a system variable transparently, the new value cannot
take effect until you start the next command.
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Enter Coordinates

Absolute and relative 2D Cartesian and polar coordinates determine precise
locations of objects in a drawing.

You can use absolute or relative Cartesian (rectangular) coordinates to locate
points when creating objects.

To use Cartesian coordinates to specify a point, enter an X value and a Y value
separated by a comma (X,Y). The X value is the positive or negative distance, in
units, along the horizontal axis. The Y value is the positive or negative distance, in
units, along the vertical axis.

Absolute coordinates are based on the UCS origin (0,0), which is the
intersection of the X and Y axes. Use absolute coordinates when you know the
precise X and Y values of the point.

With Dynamic Input, you can specify absolute coordinates with the # prefix. If
you enter coordinates on the command line instead of in the tooltip, the # prefix is not
used. For example, entering #3,4 specifies a point 3 units along the X axis and 4 units
along the Y axis from the UCS origin. For more information about Dynamic Input,
see Use Dynamic Input.

The following example draws a line (fig. 2.2) beginning at an X value of -2, a
Y value of 1, and an endpoint at 3,4. Enter the following in the tooltip:

Command: line

From point: #-2,1

To point: #3,4
The line is located as follows:
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Figure 2.2 — Cartesian (rectangular) coordinates

Relative coordinates are based on the last point entered. Use relative
coordinates when you know the location of a point in relation to the previous point.
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To specify relative coordinates, precede the coordinate values with an @ sign.
For example, entering @3,4 specifies a point 3 units along the X axis and 4 units
along the Y axis from the last point specified.

The following example draws the sides of a triangle (fig. 2.3). The first side is
a line starting at the absolute coordinates -2,1 and ending at a point 5 units in the X
direction and O units in the Y direction. The second side is a line starting at the
endpoint of the first line and ending at a point 0 units in the X direction and 3 units in
the Y direction. The final line segment uses relative coordinates to return to the
starting point.

Command. line

From point: #-2,1

To point: @5,0

To point: @0,3

To point: @-35,-3
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Figure 2.3 — Draw the sides of a triangle

You can use absolute or relative polar coordinates (distance and angle) to
locate points when creating objects.

To use polar coordinates to specify a point, enter a distance and an angle
separated by an angle bracket (<).

By default, angles increase in the counterclockwise direction and decrease in
the clockwise direction. To specify a clockwise direction, enter a negative value for
the angle. For example, entering 1<315 locates the same point as entering 1<-45. You
can change the angle conventions for the current drawing with UNITS.

Absolute polar coordinates are measured from the UCS origin (0,0), which is
the intersection of the X and Y axes. Use absolute polar coordinates when you know
the precise distance and angle coordinates of the point.

With Dynamic Input, you can specify absolute coordinates with the # prefix. If
you enter coordinates on the command line instead of in the tooltip, the # prefix is not
used. For example, entering #3<45 specifies a point 3 units from the origin at an
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angle of 45 degrees from the X axis. For more information about Dynamic Input, see
Use Dynamic Input.

The following example shows two lines drawn with absolute polar coordinates
using the default angle direction setting (fig. 2.4). Enter the following in the tooltip:

Command. line

From point: #0,0

To point: #4<120

To point: #5<30

-
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Figure 2.4 — Polar coordinates

Relative coordinates are based on the last point entered. Use relative
coordinates when you know the location of a point in relation to the previous point.

To specify relative coordinates, precede the coordinate values with an @ sign.
For example, entering @1<45 specifies a point at a distance of 1 unit from the last
point specified at an angle of 45 degrees from the X axis.

The following example shows two lines drawn with relative polar coordinates.
In each illustration, the line begins at the location labeled as the previous point.

Command.: line

From point: (@3<45

To point: @5<285

Use Dynamic Input

Dynamic Input provides a command interface near the cursor to help you keep
your focus in the drafting area.

When Dynamic Input is on, tooltips display information near the cursor that is
dynamically updated as the cursor moves. When a command is active, the tooltips
provide a place for user entry.

After you type a value in an input field and press TAB, the field then displays a
lock icon, and the cursor is constrained by the value that you entered. You can then
enter a value for the second input field. Alternately, if you type a value and press
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ENTER, the second input field is ignored and the value is interpreted as direct
distance entry.

The actions required to complete a command or to use grips are similar to those
for the command prompt. The difference is that your attention can stay near the
Cursor.

Dynamic Input is not designed to replace the command window. You can hide the
command window to add screen area for drawing, but you will need to display it for
some operations. Press F2 to hide and display command prompts and error messages
as needed. Alternately, you can undock the command window and use Auto-hide to
roll open or roll up the window.

Turn Dynamic Input On and Off

Click Dyn on the status bar to turn Dynamic Input on and off. You can turn it
off temporarily by holding down the F12 key. Dynamic Input has three components:
pointer input, dimensional input, and dynamic prompts. Right-click Dyn and click
Settings to control what is displayed by each component when Dynamic Input is on.

Pointer Input

When pointer input is on and a command is active, the location of the
crosshairs is displayed as coordinates in a tooltip near the cursor. You can enter
coordinate values in the tooltip instead of on the command line.

The default for second and subsequent points is relative polar coordinates
(relative Cartesian for RECTANG). There is no need to type the at sign (@). If you
want to use absolute coordinates, use the pound sign (#) prefix. For example, to move
an object to the origin, for the second point prompt, enter #0,0.

Use the pointer input settings to change the default format for coordinates and
to control when pointer input tooltips are displayed.

Dimensional Input

When dimensional input is on, the tooltips display distance and angle values
when a command prompts for a second point (fig. 2.5). The values in the dimensional
tooltips change as you move the cursor. Press TAB to move to the value you want to
change. Dimensional input is available for ARC, CIRCLE, ELLIPSE, LINE, and
PLINE.

When you use grips to edit an object, the dimensional input tooltips can display
the following information:

e Original length,

¢ A length that updates as you move the grip,

e The change in the length,

e Angle,
The change in the angle as you move the grip,
The radius of an arc.
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Use the dimensional input settings to display only the information you want to see.

— length change

absolute angle

Figure 2.5 — Dimensional Input

When you use grips to stretch objects or when you create new objects,
dimensional input displays only acute angles, that is, all angles are displayed as 180
degrees or less. Thus, an angle of 270 degrees is displayed as 90 degrees regardless of
the ANGDIR system variable setting (set in the Drawing Units dialog box). Angles
specified when creating new objects rely on the cursor location to determine the
positive angle direction.

Dynamic Prompts

When dynamic prompts are on, prompts are displayed in a tooltip near the
cursor. You can enter a response in the tooltip instead of on the command line. Press

the DOWN ARROW key to view and select options. Press the UP ARROW key to
display recent input.

Note. To use PASTECLIP in a dynamic prompt tooltip, type a letter and then
backspace to delete it before you paste the entry. Otherwise, the entry is pasted into
the drawing as text.

Work with Layers
Layers (fig. 2.6) are like transparent overlays on which you organize and group
objects in a drawing.

Layers are used to group information in a drawing by function and to enforce
linetype, color, and other standards.
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Layers are the equivalent of the overlays used in paper-based drafting. Layers
are the primary organizational tool used in drawing. You use layers to group
information by function and to enforce linetype, color, and other standards.
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Figure 2.6 — Layers

By creating layers, you can associate similar types of objects by assigning them
to the same layer. For example, you can put construction lines, text, dimensions, and
title blocks on separate layers. You can then control the following:

e Whether objects on a layer are visible or dimmed in any viewports,

Whether and how objects are plotted,

What color is assigned to all objects on a layer,

What default linetype and lineweight are assigned to all objects on a layer,
Whether objects on a layer can be modified,

e Whether objects display with different layer properties in individual layout
viewports.

Every drawing includes a layer named 0. Layer O cannot be deleted or
renamed. It has two purposes:

e Ensure that every drawing includes at least one layer;

e Provide a special layer that relates to controlling colors in blocks.

Note. It is recommended that you create several new layers with which to
organize your drawing rather than create your entire drawing on layer 0.

You can use layers to control the visibility of objects and to assign properties to
objects. Layers can be locked to prevent objects from being modified.

You can reduce the visual complexity of a drawing and improve display
performance by controlling how objects are displayed or plotted. For example, you
can use layers to control the properties and visibility of similar objects, such as
electrical parts or dimensions. Also, you can lock a layer to prevent objects on that
layer from being accidentally selected and modified.
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Control the Visibility of Objects on a Layer

You can make drawing layers invisible either by turning them off or by
freezing them. Turning off or freezing layers is useful if you need an unobstructed
view when working in detail on a particular layer or set of layers or if you don’t want
to plot details such as reference lines. Whether you choose to freeze layers or turn
them off depends on how you work and on the size of your drawing:

e On/Off. Objects on turned-off layers are invisible, but they still hide objects
when you use HIDE. When you turn layers on and off, the drawing is not
regenerated;

o Freeze/Thaw. Objects on frozen layers are invisible and do not hide other
objects. In large drawings, freezing unneeded layers speeds up operations involving
display and regeneration. Thawing one or more layers causes the drawing to be
regenerated. Freezing and thawing layers takes more time than turning layers on and
off.

In a layout, you can freeze layers in individual layout viewports.

Note. Instead of turning off or freezing a layer, you can dim the layer by
locking it. See Lock the Objects on a Layer.

Assign a Default Color and Linetype to a Layer

Each layer has associated properties such as color and linetype that are
assumed by all objects on that layer when the setting is ByLayer. For example, if the
Color control on the Properties toolbar is set to BYLAYER, the color of new objects
is determined by the color setting for the layer in the Layer Properties Manager.

If you set a specific color in the Color control, that color is used for all new
objects, overriding the default color for the current layer. The same is true for the
Linetype, Lineweight, and Plot Style controls on the Properties toolbar.

Lock the Objects on a Layer

When a layer is locked, none of the objects on that layer can be modified until
you unlock the layer. Locking layers reduces the possibility of modifying objects
accidentally. You can still apply object snaps to objects on a locked layer and
perform other operations that do not modify those objects.

You can also dim the objects on a locked layer. This serves the following two
purposes:

¢ You can easily see what objects are on locked layers;

¢ You can reduce the visual complexity of a drawing but still maintain visual
reference and object snapping capabilities to those objects.

The LAYLOCKFADECTL system variable controls the dimming applied to
locked layers. Locked layers that are dimmed are plotted normally.

Note. Grips are not displayed on objects that are on locked layers.
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Layer Properties Manager

It displays a list of the layers in the drawing and their properties. You can add,
delete, and rename layers, change their properties, set property overrides for layout
viewports, or add descriptions (fig. 2.7). Layer filters control which layers are
displayed in the list and can also be used to make changes to more than one layer at a
time.

New Property Filter displays the Layer Filter Properties dialog box, where
you can create a layer filter based on one or more properties of the layers.

New Group Filter creates a layer filter that contains layers that you select and
add to the filter.
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Figure 2.7 — Layer Properties Manager

Layer States Manager displays the Layer States Manager, in which you can
save the current property settings for layers in a named layer state and then restore
those settings later.

New Layer creates a new layer. The list displays a layer named LAYERI. The
name is selected so that you can enter a new layer name immediately. The new layer
inherits the properties of the currently selected layer in the layer list (color, on or off
state, and so on).

New Layer Frozen VP In All Viewports creates a new layer and freezes it in
all existing layout viewports. This button is accessible from the Model tab or layout
tabs.

Delete Layer marks selected layers for deletion. Layers are deleted when you
click Apply or OK. You can delete only unreferenced layers. Referenced layers

include layers 0 and DEFPOINTS, layers containing objects (including objects in
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block definitions), the current layer, and xref-dependent layers. Layers in a partially
opened drawing are also considered referenced and cannot be deleted.

Note. Be careful about deleting layers if you are working on a drawing in a shared
project or one based on a set of layering standards.

Set Current sets the selected layer as the current layer. Objects that you create
are drawn on the current layer. (CLAYER system variable).

Practical work

Purpose: acquiring skills of work with layers, learning how to enter
commands and points coordinates in AutoCAD

Work order:

. Create a new AutoCAD drawing and save it in the personal folder.
. Create 10 layers (with names layerl, layer 2 ..., layer 10) with different

N —

3. For every layer:
e make it current,
e draw a circle with the identical center coordinates and diameters for all the

4. Turn off all the layers, except for layer].

5. Remove the circle drawn in the layer.

6. Turn on all the layers.

7. Create layerll and draw a rectangle with sides 14 and 24, the left lower
corner coordinates are 0,0. Enter the coordinates of the points using the mouse.

8. Create layerl2. Draw a rectangle with sides 14 and 24 with the coordinates
of the left lower corner are 0,0. Enter the absolute coordinates of the points with the
keyboard.

9. Create layerl3. Draw a rectangle with sides 14 and 24, the coordinates of the
left lower corner are 0,0. Enter the relative coordinates of the points with the
keyboard.

10. Create layeri4. Draw a rectangle with sides 14 and 24, the coordinates of
the left lower corner are 0,0. Enter the absolute polar coordinates of the points with
the keyboard.

11. Create layerl5. Draw a rectangle with sides 14 and 24, the coordinates of
the left lower corner are 0,0. Enter the relative polar coordinates of the points with the
keyboard.

12. Save the drawing in the personal folder and compress it (ZIP).

13. Save this archive in the Academy distance learning system.
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Basic theoretical information

The User Interface
You can use several menus, shortcut menus, toolbars, and the dashboard to
access frequently used commands, settings, and modes.

Toolbars

Use buttons on toolbars to start commands, display flyout toolbars, and display
tooltips. You can display or hide, dock, and resize toolbars.

Toolbars contain buttons that start commands. When you move your mouse or
pointing device over a toolbar button, the tooltip displays the name of the button.
Buttons with a small black triangle in the lower-right corner are flyout toolbars that
contain related commands. With the cursor over the icon, hold down the left button
on your mouse until the flyout toolbar is displayed.

The Standard toolbar at the top of the drawing area is displayed by default.
This toolbar is similar to those found in Microsoft Office programs. It contains
frequently used AutoCAD commands such as PROPERTIES, PAN, and ZOOM, as
well as Microsoft Office standard commands such as New, Open, and Save.

Status Bars

The application and drawing status bars provide useful information, buttons for
turning on and off drawing tools.

The application status bar displays the coordinate values of your cursor along
with several buttons for turning on and off drawing tools and may display tools for
scaling annotations. You can choose which buttons you want to display in the status
bar.

The drawing status bar displays several tools for scaling annotations.

Different tools display for model space and paper space.

When the drawing status bar is turned on it displays at the bottom of the
drawing area. When the drawing status bar is turned off, the tools found on the
drawing status bar are moved to the application status bar.

When the drawing status bar is turned on, you can use the Infobar menu to
choose which tools display in status bar.

The Menu Bar

Display pull-down menus from the menu bar using one of several methods.
You can also specify alternate menus.

Menus are available from the menu bar at the top of the AutoCAD drawing
area.

To use a menu choose one of the following methods:

e On the menu bar, click a menu name to display a list of options. On the
menu, either click an option or use the DOWN ARROW to move down the list, and
then press ENTER.
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e Press ALT and press the key for the underlined letter in the menu name;
then, press the underlined letter in the option name. For example, to open a new
drawing, press ALT and press F to open the File menu; then, press N for New.

You can specify menus to display in the program by customizing a CUI file
and loading it into the program.

Shortcut Menus
Display a shortcut menu for quick access to commands that are relevant to your
current activity.
You can display different shortcut menus when you right-click different areas
of the screen, including
e Within the drawing area with or without any objects selected;
Within the drawing area during a command;
Within the text and command windows;
Within areas and on icons in DesignCenter;
Within areas and on text in the In-Place Text Editor;
On a toolbar or tool palette;
On the Model or layout tabs;
On the status bar or the status bar buttons;
In certain dialog boxes;
Shortcut menus typically include options to;
Repeat the last command entered;
Cancel the current command;
Display a list of recent user input;
Cut, copy, and paste from the Clipboard;
Select a different command option;
e Display a dialog box, such as Options or Customize;
Undo the last command entered.
You can customize right-click behavior to be time-sensitive, so that a quick
right-click acts the same as pressing ENTER, and a longer right-click displays a
shortcut menu.

Shortcut menus can be customized using a customization (CUI) file. The main
CUI file is called acad.cui by default.

The Dashboard

The dashboard is a special palette that displays buttons and controls that are
associated with a task-based workspace.

The dashboard provides a single interface element for operations that are
relevant to the current workspace. The dashboard eliminates the need to display a lot
of toolbars and reduces the clutter in the application window. Thus, you can
maximize the area available for work, and use a single interface for speed and
convenience.
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The dashboard opens automatically by default when you use either the 2D
Drafting & Annotation workspace or the 3D Modeling workspace. You can open the
dashboard manually:

e Click Tools menu » Palettes » Dashboard.

e At the Command prompt, enter dashboard.

The dashboard is organized into a series of control panels. Each control panel
includes related tools and controls that are similar to the tools in toolbars and controls
in dialog boxes.

The large icons displayed at the left side of the dashboard are called control
panel icons. Each control panel icon identifies the purpose of the control panel. On
some control panels, if you click the icon, a slide-out panel opens that contains
additional tools and controls. An open slide-out panel closes automatically when you
click another control panel icon. Only one slide-out panel is displayed at a time.

A tool palette group can be associated with each control panel. To display the
associated tool palette group, click a tool or open a slide-out panel.

You can customize the display of the dashboard (display or hide, dock, and
resize the dashboard) in the following ways:

e Size the dashboard horizontally. If not enough space is available to display
all the tools in a row, a black down-arrow called an overflow control is displayed.

e Use the shortcut menu to control the auto-hide, docking, and anchoring
behavior. With anchoring, the dashboard results is displayed as a narrow space-
saving strip along the left or right edge of the drawing area.

You can customize the dashboard in the following ways:

e You can create and modify dashboard panels using the Customize User
Interface dialog box.

e You can specify which control panels are displayed by right-clicking the
dashboard and, on the shortcut menu, clicking or clearing the names of control
panels.

¢ You can associate a customizable tool palette group with each control panel
on the dashboard. Right-click the control panel to display a list of available tool
palette groups.

Enter Commands on the Command Line

You can enter a command by using the keyboard. Some commands also have
abbreviated names called command aliases.

To enter a command by using the keyboard, type the full command name on
the command line and press ENTER or SPACEBAR.

Note. When Dynamic Input is on and is set to display dynamic prompts, you
can enter many commands in tooltips near the cursor.

Some commands also have abbreviated names. For example, instead of
entering line to start the LINE command, you can enter l. Abbreviated command
names are called command aliases and are defined in the acad.pgp file.

To find a command, you can type a letter on the command line and press TAB
to cycle through all the commands that begin with that letter. Press ENTER or
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SPACEBAR. Restart a recently used command by right-clicking on the command
line.

When you enter commands on the command line, you see either a set of
options or a dialog box. For example, when you enter circle at the Command prompt,
the following prompt is displayed:

Specify center point for circle or [3P/2P/Ttr (tan, tan, radius)]:

You can specify the center point either by entering X,Y coordinate values or by
using the pointing device to click a point on the screen.

To choose a different option, enter the letters capitalized in one of the options
in the brackets. You can enter uppercase or lowercase letters. For example, to choose
the three-point option (3P), enter 3p.

To execute commands, press SPACEBAR or ENTER, or right-click your
pointing device after entering command names or responses to prompts. The
instructions in Help assume this step and do not specifically instruct you to press
ENTER after each entry.

If you want to repeat a command that you have just used, press ENTER or
SPACEBAR, or right-click your pointing device at the Command prompt.

You also can repeat a command by entering multiple, a space, and the
command name, as shown in the following example:

Command: multiple circle

To cancel a command in progress, press ESC.

Many commands can be used transparently: that is, they can be entered on the
command line while you use another command. Transparent commands frequently
change drawing settings or display options, for example, GRID or ZOOM. In the
Command Reference, transparent commands are designated by an apostrophe in front
of the command name.

Enter Coordinates

Absolute and relative 2D Cartesian and polar coordinates determine precise
locations of objects in a drawing.

You can use absolute or relative Cartesian (rectangular) coordinates to locate
points when creating objects.

To use Cartesian coordinates to specify a point, enter an X value and a Y value
separated by a comma (X,Y). The X value is the positive or negative distance, in
units, along the horizontal axis. The Y value is the positive or negative distance, in
units, along the vertical axis.

Absolute coordinates are based on the UCS origin (0,0), which is the
intersection of the X and Y axes. Use absolute coordinates when you know the
precise X and Y values of the point.

With Dynamic Input, you can specify absolute coordinates with the # prefix. If
you enter coordinates on the command line instead of in the tooltip, the # prefix is not
used. For example, entering #3,4 specifies a point 3 units along the X axis and 4 units
along the Y axis from the UCS origin. For more information about Dynamic Input,
see Use Dynamic Input.
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Use Dynamic Input

Dynamic Input provides a command interface near the cursor to help you keep
your focus in the drafting area.

When Dynamic Input is on, tooltips display information near the cursor that is
dynamically updated as the cursor moves. When a command is active, the tooltips
provide a place for user entry.

After you type a value in an input field and press TAB, the field then displays a
lock icon, and the cursor is constrained by the value that you entered. You can then
enter a value for the second input field. Alternately, if you type a value and press
ENTER, the second input field is ignored and the value is interpreted as direct
distance entry.

The actions required to complete a command or to use grips are similar to those
for the command prompt. The difference is that your attention can stay near the
Cursor.

Dynamic Input is not designed to replace the command window. You can hide
the command window to add screen area for drawing, but you will need to display it
for some operations. Press F2 to hide and display command prompts and error
messages as needed. Alternately, you can undock the command window and use
Auto-hide to roll open or roll up the window.

Work with Layers

Layers are like transparent overlays on which you organize and group objects
in a drawing.

Layers are used to group information in a drawing by function and to enforce
linetype, color, and other standards.

Layers are the equivalent of the overlays used in paper-based drafting. Layers
are the primary organizational tool used in drawing. You use layers to group
information by function and to enforce linetype, color, and other standards.

By creating layers, you can associate similar types of objects by assigning them
to the same layer. For example, you can put construction lines, text, dimensions, and
title blocks on separate layers. You can then control the following:

o Whether objects on a layer are visible or dimmed in any viewports.

Whether and how objects are plotted.

What color is assigned to all objects on a laye.

What default linetype and lineweight are assigned to all objects on a layer;
Whether objects on a layer can be modified.

Whether objects display with different layer properties in individual layout
viewports.

Every drawing includes a layer named 0. Layer O cannot be deleted or
renamed. It has two purposes:

¢ Ensure that every drawing includes at least one layer.

e Provide a special layer that relates to controlling colors in blocks.
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Layer Properties Manager

It displays a list of the layers in the drawing and their properties. You can add,
delete, and rename layers, change their properties, set property overrides for layout
viewports, or add descriptions. Layer filters control which layers are displayed in the
list and can also be used to make changes to more than one layer at a time.

Self-examination questions

1. Graphical user interface, its components. Ways to enter control commands.
System variables.

2. Setting up the user’s work environment.

3. The procedure for preparing a graphical screen, setting up the drawing
environment. Select the size of the graphic area of the image, units of measurement,
accuracy and other parameters.

4. Grid, snap to grid mode. Orthogonal mode. Change the position of the grid
relative to the coordinate axes.

5. When objects on a layer are visible or dimmed in any viewports

6. When and how objects are plotted.

7. What color is assigned to all objects on a layer.

8. What default linetype and lineweight are assigned to all objects on a layer.

9. When objects on a layer can be modified.

10. Whether objects display with different layer properties in individual layout
viewports.

11. Why layer 0 cannot be deleted or renamed.
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Chapter 3
Creation of AutoCAD entities. Part 1

Draw Lines

In a simple /ine with connected segments, each segment is a separate line
object.

With LINE, you can create a series of contiguous line segments.

Each single line segment can be edited separately from the other line segments
in a series. You can close a sequence of line segments so that the first and last
segments are joined.

You specify the locations that define the endpoints of each line with precision.
You can:

e Enter the coordinate values for an endpoint, using either absolute or relative
coordinates;

e Specify an object snap relative to an existing object. For example, you can
specify the center of a circle as one endpoint of the line;

e Turn grid snap on and snap to a location.

Use polyline objects instead of line objects if you want the segments to be
connected as a single object.

Using LINE command

Toolbar: Draw /
Menu: Draw » Line
Command entry: line

Specify first point: Specify a point or press ENTER to continue from the last drawn

line or arc

Specify next point or [Close/Undo] :

Continue

Continues a line from the endpoint of the most recently drawn line.

If the most recently drawn line is an arc, its endpoint defines the starting point
of the line, and the line is drawn tangent to the arc.

Close

Ends the last line segment at the beginning of the first line segment, which
forms a closed loop of line segments. You can use Close after you have drawn a
series of two or more segments.

Undo

Erases the most recent segment of a line sequence.

Entering u more than once backtracks through line segments in the order you
created them.
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Drawing with the Line tool examples
Open AutoCAD. The drawing area will show the settings of the acadiso.dwt

template — Limits set to 420,297, Grid set to 10, Snap set to 5 and Units set to 0.
Left-click on the Line tool in the 2D Draw control panel (fig. 3.1).

%

2D Draw

Line

Figure 3.1 — Draw control panel

The prompt Command: _line Specify first point: which appears in the command
window at the command line.

Make sure Snap is on by either pressing the F9 key or the SNAP button in the
status bar. <Snap on> will show in the command palette.

Move the mouse around the drawing area. The cursor’s pick box will jump
from point to point at 5 unit intervals. The position of the pick box will show as
coordinate numbers in the status bar (left-hand end).

Move the mouse until the coordinate numbers show 60,240,0 and press the Pick
button of the mouse (left-click).

Move the mouse until the coordinate numbers show 260,240,0 and /eft-click.

Move the mouse until the coordinate numbers show 260,110,0 and /eft-click.

Move the mouse until the coordinate numbers show 60,110,0 and left-click.

Move the mouse until the coordinate numbers show 60,240,0 and left-click.

Then press the Return button of the mouse (right-click).

Second example

Close the drawing and open a new drawing

Lefi-click on the Line tool icon and enter figures as follows at each prompt of
the command line sequence:

Command:_line Specify first point: enter 80,235 right-click

Specify next point or [Undo]: enter 275,235 right-click

Specify next point or [Undo]: enter 295,210 right-click

Specify next point or [Close/Undo]: enter 295,100 right-click

Specify next point or [Close/Undo]: enter 230,100 right-click

Specify next point or [Close/Undo]: enter 230,70 right-click

Specify next point or [Close/Undo]: enter 120,70 right-click

Specify next point or [Close/Undo]: enter 120,100 right-click
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Specify next point or [Close/Undo]: enter 55,100 right-click
Specify next point or [Close/Undo]: enter 55,210 right-click
Specify next point or [Close/Undo]: enter ¢ (Close) right-click

Third example

Close the drawing and open a new acadiso.dwt window.

Left-click on the Line tool icon and enter figures as follows at each prompt of
the command line sequence:

Command:_line Specify first point: enter 60,210 right-click

Specify next point or [Undo]: enter @50,0 right-click

Specify next point or [Undo]: enter @0,20 right-click

Specify next point or [Close/Undo]: enter @130,0 right-click

Specify next point or [Close/Undo]: enter @0, -20 right-click

Specify next point or [Close/Undo]: enter @50,0 right-click

Specify next point or [Close/Undo]: enter @0,-105 right-click

Specify next point or [Close/Undo]: enter (@—50,0 right-click

Specify next point or [Close/Undo]: enter @0,-20 right-click

Specify next point or [Close/Undo]: enter @—130,0 right-click

Specify next point or [Close/Undo]: enter @0,20 right-click

Specify next point or [Close/Undo]: enter (@—50,0 right-click

Specify next point or [Close/Undo]: enter ¢ (Close) right-click

Notes.

The figures typed at the keyboard determining the corners of the outlines in the
above examples are two-dimensional (2D) x, y coordinate points. When working
in 2D, coordinates are expressed in terms of two numbers separated by a comma.

Coordinate points can be shown as positive or negative numbers.

The method of constructing an outline as shown in the first two examples is
known as the absolute coordinate entry method, where the X, y coordinates of each
corner of the outlines are entered at the command line as required.

The method of constructing an outline as in the third example is known as the
relative coordinate entry method — coordinate points are entered relative to the previous
entry. In relative coordinate entry, the (@ symbol is entered before each set of
coordinates with the following rules in mind.

The next example (the fourth) shows how lines at angles can be drawn taking
advantage of the relative coordinate entry method. Angles in AutoCAD are measured
in 360 degrees in a counter-clockwise (anticlockwise) direction. The < symbol
precedes the angle.

Fourth example
Left-click on the Line tool icon and enter figures as follows at each prompt of
the command line sequence:
Command:_line Specify first point: 70,230
Specify next point: @220,0
Specify next point: @0, — 70
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Specify next point or [Undo]: @115 <225
Specify next point or [Undo]: @ — 60,0

Specify next point or [Close/Undo]: @115 < 135
Specify next point or [Close/Undo]: @0,70
Specify next point or [Close/Undo]: ¢ (Close)

Fifth example

Another method of constructing accurate drawings is by using a method known
as tracking. When Line is in use, as each Specify next point: appears at the command
line, a rubber-banded line appears from the last point entered. Drag the rubber-band
line in any direction and enter a number at the keyboard, followed by a right-click.
The line is drawn in the dragged direction of a length in units equal to the entered
number.

In this example because all lines are drawn in either the vertical or the
horizontal direction, either press the F8 key or click the ORTHO button in the status
bar.

Left-click on the Line tool icon and enter figures as follows at each prompt of
the command line sequence:

Command:_line Specify first point: enter 65,220 right-click

Specify next point: drag to right enter 240 right-click

Specify next point: drag down enter 145 right-click

Specify next point or [Undo]: drag left enter 65 right-click

Specify next point or [Undo]: drag upwards enter 25 right-click

Specify next point or [Close/Undo]: drag left enter 120 right-click

Specify next point or [Close/Undo]: drag upwards enter 25 right-click

Specify next point or [Close/Undo]: drag left enter 55 right-click

Specify next point or [Close/Undo]: ¢ (Close) right-click

Draw Circles

To create circles, you can specify various combinations of center, radius,
diameter, points on the circumference, and points on other objects (fig. 3.2).

You can create circles in several ways. The default method is to specify the
center and the radius. Three other ways to draw a circle are shown in the illustration.

Draw a Circle Tangent to Other Objects
The tangent point is a point where an object touches another object without
intersecting it. To create a circle that is tangent to other objects, select the objects and
then specify the radius of the circle. In the illustrations below, the bold circle is the
one being drawn, and points 1 and 2 select the objects to which it is tangent.
To create a circle tangent at three points, set running object snaps (OSNAP) to
Tangent and use the three-point method to create the circle.
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Figure 3.2 — Draw Circles

Using CIRCLE command

Toolbar: Draw @

Menu: Draw » Circle

Command entry: circle

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: Specify a point
or enter an option
Center Point

Draws a circle based on a center point and a diameter or a radius.

Specify radius of circle or [Diameter]: Specify a point, enter a value, enter d,
or press ENTER.
Radius

Defines the radius of the circle. Enter a value, or specify a point (2). The
distance between this point and the center point determines the radius of the circle.
Diameter

Draws a circle using the center point and a specified distance for the diameter.

Specify diameter of circle <current>: Specify a point (2), enter a value, or
press ENTER
3P (Three Points)

Draws a circle based on three points on the circumference.

Specify first point on circle: Specify a point (1)

Specify second point on circle: Specify a point (2)

Specify third point on circle: Specify a point (3)
2P (Two Points)

Draws a circle based on two endpoints of the diameter.

Specify first endpoint of circle’s diameter: Specify a point (1)

Specify second endpoint of circle’s diameter: Specify a point (2)
TTR (Tangent, Tangent, Radius)

Draws a circle with a specified radius tangent to two objects.

Specify point on object for first tangent of circle: Select a circle, arc, or line.
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Specify point on object for second tangent of circle: Select a circle, arc, or line.

Specify radius of circle <current>:

Sometimes more than one circle matches the specified criteria. The program
draws the circle of the specified radius whose tangent points are closest to the
selected points.

Drawing with the Circle tool examples

Left-click on the Circle tool icon in the 2D Draw control panel
Enter numbers against the prompts appearing in the command window
The circle appears on screen

Second example

Left-click on the Circle tool icon and construct two circles (radius 50) as shown
in the drawing

Click the Circle tool again and against the first prompt enter t (the abbreviation
for the prompt tan tan radius), followed by a right-click.

Command: _circle Specify center point for circle or [3P/2P/Ttr (tan tan radius]:
enter t right-click

Specify point on object for first tangent of circle: pick

Specify point on object for second tangent of circle: pick

Specify radius of circle (50): enter 40 right-click

When a point on either circle is picked the Deferred Tangent tip appears. This
tip will only appear when the OSNAP button is set on with a click on its button in the
status bar, or by pressing the F3 key of the keyboard.

Circles can be drawn through 3 points or 2 points entered at the command line
in response to prompts brought to the command line by using 3P and 2P in answer to
the circle command line prompts

Draw Arcs
To create an arc, you can specify various combinations of center, endpoint,
start point, radius, angle, chord length, and direction values.
You can create arcs in several ways. With the exception of the first method,
arcs are drawn counterclockwise from the start point to the endpoint.
Draw Arcs by Specifying Three Points
You can draw an arc by specifying three points. In the following example, the

start point of the arc snaps to the endpoint of a line. The second point of the arc snaps
to the middle circle in the illustration.
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Draw Arcs by Specifying Start, Center, End

When you know the start point, center point, and endpoint, you can draw an arc by
specifying either the start point or the center point first. The center point is the center
of a circle that the arc is part of.

Draw Arcs by Specifying Start, Center, Angle

When you have a start point and a center point you can snap to and you
know the included angle, use the Start, Center, Angle or the Center, Start, Angle
option (fig. 3.3).

The included angle determines the endpoint of the arc. Use the Start, End,
Angle method when you know both endpoints but cannot snap to a center point.

siart, center, angle center, start, angle start, end, angle

Figure 3.3 — Draw Arcs by Specifying Start, Center, Angle
Draw Arcs by Specifying Start, Center, Length

When you have a start point and a center point you can snap to; when you
know the chord length, use the Start, Center, Length or the Center, Start, Length

option (fig. 3.4).
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Figure 3.4 — Draw Arcs by Specifying Start, Center, Length

The length of the chord of the arc determines the included angle.
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Draw Arcs by Specifying Start, End, Direction/Radius

When you have a start point and an endpoint, use the Start, End, Direction or
the Start, End, Radius option.

The illustration on the left shows an arc drawn by specifying a start point,
endpoint, and radius. You can specify the radius by entering a length or by moving
the pointing device clockwise or counterclockwise and clicking to specify a distance.
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Figure 3.5 — Draw Arcs by Specifying Start, End, Direction/Radius

The illustration on the right shows an arc drawn with the pointing device by
specifying a start point and an endpoint and a direction. Moving the cursor up from
the start point and endpoint draws the arc concave to the object, as shown here.
Moving the cursor down draws the arc convex to the object.

Draw Contiguous Arcs and Lines

Immediately after you complete an arc, you can start a line tangent to the arc at
an endpoint by starting the LINE command and pressing ENTER at the Specify First
Point prompt. You need to specify only the line length.

Conversely, after you complete a line, you can start an arc tangent to the line at
an endpoint by starting the ARC command and pressing ENTER at the Specify Start
Point prompt. You need to specify only the endpoint of the arc.

You can connect sequentially drawn arcs in the same way. To create connected
arcs using a menu, click Draw menu » Arc » Continue. In both cases, the resulting
object is tangent to the previous one. You can use the shortcut menu to repeat the
Continue option.

Drawing with the Arc tool examples

In AutoCAD 2008, arcs can be constructed using any three of the following
characteristics of an arc: its Start point; a point on the arc (Second point); its Center;
its End; its Radius; Length of the arc; Direction in which the arc is to be constructed;
Angle between lines of the arc.

In the examples which follow, enfering initials for these characteristics in
response to prompts at the command line when the Arc tool is called allows arcs to be
constructed in a variety of ways.
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To call the Arc tool click on its tool icon in the 2D Draw control panel or click
on Arc in the Draw drop-down menu. A sub-menu shows the possible methods of
constructing arcs. The abbreviation for calling the Arc tool is a.

Left-click the Arc tool icon. The command line shows:

Command:_arc Specify start point of arc or [Center]: 100,220

Specify second point of arc or [Center/End]: 55,250

Specify end point of arc: 10,220

Command:

Second example

Command: right-click brings back the Arc sequence

ARC Specify start point of arc or [Center]: ¢ (Center)
Specify center point of arc: 200,190

Specify start point of arc: 260,215

Specify end point of arc or [Angle/chord Length]: 140,215
Command:

Third example

Command: right-click brings back the Arc sequence

ARC Specify start point of arc or [Center]: 420,210

Specify second point of arc or [Center/End]: e (End)

Specify end point of arc: 320,210

Specify center point of arc or [Angle/Direction/Radius]: r (Radius)
Specify radius of arc: 75

Command:

Draw Polylines

A polyline (fig. 3.6) is a connected sequence of line segments created as a
single object. You can create straight line segments, arc segments, or a combination
of the two.

A

pipe symbaol differing widths

Figure 3.6 — Draw Polylines
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Multisegmented lines provide editing capabilities unavailable for single lines.
For example, you can adjust their width and curvature. After you’ve created a
polyline, you can edit it with PEDIT or use EXPLODE to convert it to individual line
and arc segments. You can:

e Convert a spline-fit polyline into a true spline with SPLINE;

e Use closed polylines to create a polygon;

e Create a polyline from the boundaries of overlapping objects.

Create Arc Polylines

When you draw arc segments in a polyline, the first point of the arc is the
endpoint of the previous segment. You can specify the angle, center point, direction,
or radius of the arc. You can also complete the arc by specifying a second point and
an endpoint.

Create Closed Polylines

You can draw a closed polyline to create a polygon. To close a polyline,
specify the starting point of the last side of the object, enter ¢ (Close), and press
ENTER.

Create Wide Polylines

You can draw polylines of various widths by using the Width and Halfwidth
options. You can set the width of individual segments and make them taper gradually
from one width to another. These options become available after you specify a
starting point for the polyline.

The Width and Halfwidth options set the width of the next polyline segments
you draw. Zero (0) width produces a thin line. Widths greater than zero produce wide
lines, which are filled if Fill mode is on and outlined if Fill mode is off. The
Halfwidth option sets width by specifying the distance from the center of the wide
polyline to an outside edge.

Taper

When you use the Width option, you are prompted for both a starting and an
ending width. By entering different values, you can taper the polyline. The starting
and ending points of wide polyline segments are in the center of the line.
Intersections of adjacent wide segments are usually beveled. However, nontangent
arc segments, acute angles, or segments that use a dash-dot linetype are not beveled.

Create Polylines from the Boundaries of Objects

You can create a polyline from the boundaries of overlapping objects that form
a closed area. A polyline created using the boundary method is a separate object,
distinct from the objects used to create it. You can edit it using the same methods
used to edit other polylines.
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To expedite the boundary selection process in large or complex drawings, you
can specify a group of boundary candidates, called a boundary set. You create this set
by selecting the objects you want to use define the boundary.

Drawing with the Polyline tool examples

When drawing lines with the Line tool, each line drawn is an object in its own
right. A rectangle drawn with the Line tool is four objects. A rectangle drawn with the
Polyline tool is a single object. Lines of different thickness, arcs, arrows and circles
can all be drawn using this tool as will be shown in the examples describing
constructions using the Polyline tool. Constructions resulting from using the tool are
known as polylines or plines.

The Polyline tool can be called from the 2D Draw control panel or from the
Draw toolbar

Left-click the Polyline tool. The command line shows (In this example enfer and
right-click have not been included)

Command:_pline Specify start point: 30,250

Current line width is 0

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 230,250

Specify next point or [ Arc/Close/Halfwidth/Length/Undo/Width]: 230,120

Specify next point or [ Arc/Close/Halfwidth/Length/Undo/Width]: 30,120

Specify next point or [ Arc/Close/Halfwidth/Length/Undo/Width]: ¢ (Close)

Note the prompts — Arc for constructing pline arcs; Close to close an outline;
Halfwidth to halve the width of a wide pline; Length to enter the required length of a
pline; Undo to undo the last pline constructed; Close to close an outline.

Only the capital letter(s) of a prompt needs to be entered in upper or lower case
to make that prompt effective.

Only the capital letter(s) of a prompt needs to be entered in upper or lower case
to make that prompt effective.

Other prompts will appear when the Polyline tool is in use as will be shown in
later examples.

Second example

This will be a long sequence, but it is typical of a reasonably complex drawing
using the Polyline tool. In the following sequences, when aprompt line is to be
repeated, the prompts in square brackets ([ ]) will be replaced by [prompts].

Left-click the Polyline tool icon. The command line shows:

Command: pline Specify start point: 40,250

Current line width is 0

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: w (Width)

Specify starting width <0>: 5

Specify ending width <5>: right-click

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 160,250

Specify next point or [prompts]: h (Halfwidth)

45



Specify starting half-width <2.5>: 1
Specify ending half-width <1>: right-click
Specify next point or [prompts]: 260,250
Specify next point or [prompts]: 260,180
Specify next point or [prompts]: w (Width)
Specify starting width <1>: 10

Specify ending width <10>: right-click
Specify next point or [prompts]: 260,120
Specify next point or [prompts]: h (Halfwidth)
Specify starting half-width <5>: 2

Specify ending half-width <2>: right-click
Specify next point or [prompts]: 160,120
Specify next point or [prompts]: w (Width)
Specify starting width <4>: 20

Specify ending width <20>: right-click
Specify next point or [prompts]: 40,120
Specify starting width <20>: 5

Specify ending width <5>: right-click
Specify next point or [prompts]: ¢ (Close)

Third example

Left-click the Polyline tool icon. The command line shows:
Command: pline Specify start point: 50,220
Current line width is 0

[prompts]: w (Width)

Specify starting width <0>: 0.5

Specify ending width <0.5>: right-click

Specify next point or [prompts]: 120,220

Specify next point or [prompts]: a (Arc)

Specify endpoint of arc or [prompts]: s (second pt)
Specify second point on arc: 150,200

Specify end point of arc: 180,220

Specify end point of arc or [prompts]: I (Line)
Specify next point or [prompts]: 250,220

Specify next point or [prompts]: 250,190

Specify next point or [prompts]: a (Arc)

Specify endpoint of arc or [prompts]: s (second pt)
Specify second point on arc: 240,170

Specify end point of arc: 250,150

Specify end point of arc or [prompts]: I (Line)
Specify next point or [prompts]: 250,150

Specify next point or [prompts]: 250,120

And so on until the outline in the picture is completed.
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Fourth example

Left-click the Polyline tool icon. The command line shows:
Command: pline Specify start point: 80,170
Current line width is 0

Specify next point or [prompts]: w (Width)
Specify starting width <0>: 1

Specify ending width <1>: right-click

Specify next point or [prompts]: a (Arc)

Specify endpoint of arc or [prompts]: s (second pt)
Specify second point on arc: 160,250

Specify end point of arc: 240,170

Specify end point of arc or [prompts]: ¢l (CLose)
The circle in the picture is formed

Fifth example

Left-click the Polyline tool icon. The command line shows:
Command: pline Specify start point: 60,180
Current line width is 0

Specify next point or [prompts]: w (Width)
Specify starting width <0>: 1

Specify ending width <1>: right-click
Specify next point or [prompts]: 190,180
Specify next point or [prompts]: w (Width)
Specify starting width <1>: 20

Specify ending width <20>: 0

Specify next point or [prompts]: 265,180
Specify next point or [prompts]: right-click
The arrow in the picture is formed.

Practical work

Purpose: to confirm skills of work with drawings and layers, to become
acquainted with the procedures of drawing and displaying of drawings, to learn
how to draw lines segments, circles, arcs and polylines in AutoCAD

Work order

1. Create a new drawing in AutoCAD and save it in the personal folder under
the name tsk1.dwg.

2. Set the units of measurement to meters.

3. Set the limits of the drawing to -500,-500 and 10000,100000.

4. Set SNAP and GRID equal to 0.5 m.

5. Create a new layer.
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6. Using the LINE, CIRCLE and ARC commands, draw a basketball court plan
(length 24 m, width 14 m, the lower left corner on point 0,0).

7. Create a new layer.

8. Draw all the lines of the basketball court plan created in No.6 over with
polylines (width 0.1 m).

9. Save the drawing in the personal folder and compress it (Zip).

10. Save this archive in the Academy distance learning system.

Basic theoretical information

Draw Lines

In a simple /ine with connected segments, each segment is a separate line
object.

With LINE, you can create a series of contiguous line segments.

Each single line segment can be edited separately from the other line segments
in a series. You can close a sequence of line segments so that the first and last
segments are joined.

You specify the locations that define the endpoints of each line with precision.
You can:

e Enter the coordinate values for an endpoint, using either absolute or
relative coordinates;

e Specify an object snap relative to an existing object. For example, you can
specify the center of a circle as one endpoint of the line;

e Turn grid snap on and snap to a location.

Use polyline objects instead of line objects if you want the segments to be
connected as a single object.

Draw Circles. To create circles, you can specify various combinations of
center, radius, diameter, points on the circumference, and points on other objects.

You can create circles in several ways. The default method is to specify the
center and the radius. Three other ways to draw a circle are shown in the illustration.

Draw a Circle Tangent to Other Objects. The tangent point is a point where
an object touches another object without intersecting it. To create a circle that is
tangent to other objects, select the objects and then specify the radius of the circle. In
the illustrations below, the bold circle is the one being drawn, and points 1 and 2
select the objects to which it is tangent.

To create a circle tangent at three points, set running object snaps (OSNAP) to
Tangent and use the three-point method to create the circle.

To create an arc, you can specify various combinations of center, endpoint,
start point, radius, angle, chord length, and direction values.

You can create arcs in several ways. With the exception of the first method,
arcs are drawn counterclockwise from the start point to the endpoint.

Draw Arcs by Specifying Three Points. You can draw an arc by specifying
three points. In the following example, the start point of the arc snaps to the endpoint
of a line. The second point of the arc snaps to the middle circle in the illustration.
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Draw Arcs by Specifying Start, Center, End. When you know the start point,
center point, and endpoint, you can draw an arc by specifying either the start point or
the center point first. The center point is the center of a circle that the arc is part of.

Draw Arcs by Specifying Start, Center, Angle. When you have a start point
and a center point you can snap to and you know the included angle, use the Start,
Center, Angle or the Center, Start, Angle option.

The included angle determines the endpoint of the arc. Use the Start, End,
Angle method when you know both endpoints but cannot snap to a center point.

Draw Arcs by Specifying Start, Center, Length. When you have a start point
and a center point you can snap to; when you know the chord length, use the Start,
Center, Length or the Center, Start, Length option.

The length of the chord of the arc determines the included angle.

Draw Arcs by Specifying Start, End, Direction/Radius. When you have a
start point and an endpoint, use the Start, End, Direction or the Start, End, Radius
option.

The illustration on the left shows an arc drawn by specifying a start point,
endpoint, and radius. You can specify the radius by entering a length or by moving
the pointing device clockwise or counterclockwise and clicking to specify a distance.

The illustration on the right shows an arc drawn with the pointing device by
specifying a start point and an endpoint and a direction. Moving the cursor up from
the start point and endpoint draws the arc concave to the object, as shown here.
Moving the cursor down draws the arc convex to the object.

Draw Polylines

A polyline is a connected sequence of line segments created as a single object.
You can create straight line segments, arc segments, or a combination of the two.

Multisegmented lines provide editing capabilities unavailable for single lines.
For example, you can adjust their width and curvature. After you’ve created a
polyline, you can edit it with PEDIT or use EXPLODE to convert it to individual line
and arc segments. You can:

e Convert a spline-fit polyline into a true spline with SPLINE.

e Use closed polylines to create a polygon.

e (reate a polyline from the boundaries of overlapping objects.

Create Arc Polylines. When you draw arc segments in a polyline, the first
point of the arc is the endpoint of the previous segment. You can specify the angle,
center point, direction, or radius of the arc. You can also complete the arc by
specifying a second point and an endpoint.

Create Closed Polylines. You can draw a closed polyline to create a polygon.
To close a polyline, specify the starting point of the last side of the object, enter c
(Close), and press ENTER.

Create Wide Polylines. You can draw polylines of various widths by using the
Width and Halfwidth options. You can set the width of individual segments and make
them taper gradually from one width to another. These options become available after
you specify a starting point for the polyline.
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The Width and Halfwidth options set the width of the next polyline segments
you draw. Zero (0) width produces a thin line. Widths greater than zero produce wide
lines, which are filled if Fill mode is on and outlined if Fill mode is off. The
Halfwidth option sets width by specifying the distance from the center of the wide
polyline to an outside edge.

Taper. When you use the Width option, you are prompted for both a starting
and an ending width. By entering different values, you can taper the polyline. The
starting and ending points of wide polyline segments are in the center of the line.
Intersections of adjacent wide segments are usually beveled. However, nontangent
arc segments, acute angles, or segments that use a dash-dot linetype are not beveled.

Create Polylines from the Boundaries of Objects. You can create a polyline
from the boundaries of overlapping objects that form a closed area. A polyline
created using the boundary method is a separate object, distinct from the objects used
to create it. You can edit it using the same methods used to edit other polylines.

To expedite the boundary selection process in large or complex drawings, you
can specify a group of boundary candidates, called a boundary set. You create this set
by selecting the objects you want to use define the boundary.

Self-examination questions

Elements of the drawing: layers, entities, blocks, views.

Parameters and properties of drawing elements.

Layer properties.

Ways to create layers.

Manage layers.

Features of the zero layer.

Preparation for drawing.

Selection of the current layer, color, line type and other parameters.
9. Methods and techniques of drawing entities.

10. How to draw a line?

11. How to draw a circle tangent to other objects?

12. How to draw a circle based on three points on the circumference?
13. How to draw a circle based on two endpoints of the diameter?

14. How to draw a circle with a specified radius tangent to two objects?
15. How to draw an arc by specifying three points?

16. How to draw an arc by specifying start point, center point, and endpoint?
17. How to draw an arc by specifying start, center, angle?

18. How to draw an arc by specifying start, center, length?

XA B LD =
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Chapter 4
Creation of AutoCAD entities. Part 2

Draw Ellipses

The shape of an ellipse is determined by two axes that define its length and
width. The longer axis is called the major axis, and the shorter one is the minor axis.

digtance

%
.

distance %

midpoint of first
axis

Mmajor axis

endpoints of first axis minor axis

Figure 4.1 — Draw Ellipses

The illustrations below (fig. 4.1) show two different ellipses created by
specifying axis and distance. The third point specifies only a distance and does not
necessarily designate the axis endpoint.

If you are drawing on isometric planes to simulate 3D, you can use ellipses to
represent isometric circles viewed from an oblique angle. First you need to turn on
Isometric Snap in the Drafting Settings dialog box.

Drawing with the Ellipse tool examples

Ellipses can be regarded as what is seen when a circle is viewed from directly
in front of the circle and the circle rotated through an angle about its horizontal
diameter (fig. 4.2). Ellipses are measured in terms of two axes - a major axis and a
minor axis, the major axis being the diameter of the circle, the minor axis being the
height of the ellipse after the circle has been rotated through an angle.
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Figure 4.2 — Different Ways to Draw Ellipses

To call the Ellipse tool, click on its tool icon in the 2D Draw control panel or

click on its name in the Draw drop-down menu. The abbreviation for calling the
Ellipse tool is el.

Left-click the Ellipse tool icon. The command line shows:
Command:_ellipse

Specify axis endpoint of elliptical arc or [Center]: 30,190
Specify other endpoint of axis: 150,190

Specify distance to other axis or [Rotation]: 25
Command:

Second example

In this second example, the coordinates of the center of the ellipse (the point

where the two axes intersect) are entered, followed by entering coordinates for the
end of the major axis, and followed by entering the units for the end of the minor

axis.

Command: right-click

ELLIPSE

Specify axis endpoint of elliptical arc or [Center]: ¢
Specify center of ellipse: 260,190

Specify endpoint of axis: 205,190

Specify distance to other axis or [Rotation]: 30
Command:

Third example

Command: right-click

ELLIPSE

Specify axis endpoint of elliptical arc or [Center]: 30,100
Specify other endpoint of axis: 120,100

Specify distance to other axis or [Rotation]: r (Rotation)
Specify rotation around major axis: 45

Command:
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Draw Rectangles

Use RECTANG command to create closed polylines in a rectangular shape.
You can specify the length, width, area, and rotation parameters. You can also control
the type of corners on the rectangle-fillet, chamfer, or square.

Toolbar: Draw
Menu: Draw » Rectangle At the Command prompt, enter rectang.
Command entry: rectang or rectangle.

Drawing with the Rectangle tool examples

Call the Rectangle tool - either, with a click on its tool icon in the 2D Draw
control panel, or by entering rec or rectangle at the command line.

The tool can be called from the Draw drop-down menu.

The command line shows:

Command:_rectang

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ Width]:
25,240

Specify other corner point or [Area/Dimensions/Rotation]:

160,160

Command:

Command:_rectang

[prompts]: ¢ (Chamfer)

Specify first chamfer distance for rectangles <0>: 15

Specify first chamfer distance for rectangles <15>: right-click
Specify first corner point: 200,240

Specify other corner point: 300,160

Command:

Command:_rectang

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: w
(Width)

Specify line width for rectangles <0>: 4

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ Width]: ¢
(Chamfer)

Specify first chamfer distance for rectangles <0>: 10

Specify second chamfer distance for rectangles <10>: 15

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/ Width]:
200,120

Specify other corner poi nt or [Area/Dimensions/Rotation]: 315,25

Command:
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Draw Regular Polygons

Use POLYGON command to create closed polylines with between 3 and 1,024
equal-length sides. The following illustrations (fig. 4.3) show polygons created using
three methods. In each case, two points are specified.
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Figure 4.3 — Draw Regular Polygons
Drawing with the Polygon tool examples (fig. 4.4)

Call the Polygon tool — either with a click on its tool icon in the 2D Draw
control panel, by entering pol or polygon at the command line.

It can be called from the Draw drop-down menu.

The command line shows

Command:_polygon Enter number of sides <4>: 6

Specify center of polygon or [Edge]: 60,210

Enter an option [Inscribed in circle/Circumscribed about circle] <I>: right-click
(accept Inscribed)

Specify radius of circle: 60

Command:

In the same manner construct a 5-sided polygon of centre 200,210 and of
radius 60.

Then, construct an 8-sided polygon of centre 330,210 and radius 60.

Repeat to construct a 9-sided polygon circumscribed about a circle of radius 60
and centre 60, 80.

Construct yet another polygon with 10 sides of radius 60 and of centre 200,80.

Finally another polygon circumscribing a circle of radius 60, of centre 330,80
and sides 12.
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Figure 4.4 — Drawing with the Polygon tool examples
Draw Donuts

Donuts are filled rings or solid-filled circles that actually are closed polylines
with width.
To create a donut, you specify its inside and outside diameters and its center.
You can continue creating multiple copies with the same diameter by specifying
different center points. To create solid-filled circles, specify an inside diameter of 0.
To create a donut
Click Draw menu » Donut. At the Command prompt, enter donut.
Specify the inside diameter (1).
Specify the outside diameter (2).
Specify the center of the donut (3).
5. Specify the center point for another donut, or press ENTER to complete
the command.

el

Practical work

Purpose: confirming skills of work with drawing and displaying
procedures, learning how to draw ellipses, polygons and rings in AutoCAD/
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Work order

1. Start AutoCAD and open the drawing #skl.dwg.

2. Create a new layer.

3. Set SNAP and GRID equal to 2 m.

4. Around the basketball court, draw stands in the form of five ellipses. The
centers of all the ellipses coincide with the center of basketball court, and the axes are
magnified by 2 m.

5. Create a new layer.

6. Near the basketball court, draw a booth of 9-side polygon described around a
circle of 3 m diameter.

7. Create a new layer.

8. Near the basketball court, draw a 7-side booth inscribed into a circle of 4 m
diameter.

9. Create a new layer.

10. Set SNAP and GRID equal to 0.1m.

11. Near the basketball court, draw 3 flowerbeds as rings (using the DONUT
command). Internal diameters are 2m, 2.5m, and 3m. The widths of the rings are
0.2m, 0.3m, 0.4m.

12. Save the drawing in the personal folder and compress it (Zip).

13. Save this archive in the Academy distance learning system.

Basic theoretical information

Draw Ellipses

The shape of an ellipse is determined by two axes that define its length and
width. The longer axis is called the major axis, and the shorter one is the minor axis.

The illustrations below show two different ellipses created by specifying axis
and distance. The third point specifies only a distance and does not necessarily
designate the axis endpoint.

If you are drawing on isometric planes to simulate 3D, you can use ellipses to
represent isometric circles viewed from an oblique angle. First you need to turn on
Isometric Snap in the Drafting Settings dialog box.

Draw Rectangles

Use RECTANG command to create closed polylines in a rectangular shape.
You can specify the length, width, area, and rotation parameters. You can also control
the type of corners on the rectangle—fillet, chamfer, or square.

Draw Regular Polygons

Use POLYGON command to create closed polylines with between 3 and 1,024
equal-length sides.

Draw Donuts

Donuts are filled rings or solid-filled circles that actually are closed polylines
with width.
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To create a donut, you specify its inside and outside diameters and its center.
You can continue creating multiple copies with the same diameter by specifying
different center points. To create solid-filled circles, specify an inside diameter of 0.
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Self-examination questions

Elements of the drawing: layers, entities, blocks, views.
Parameters and properties of drawing elements.

Layer properties.

Ways to create layers.

Manage layers.

Features of the zero layer.

Preparation for drawing.

Selection of the current layer, color, line type and other parameters.
Methods and techniques of drawing entities.

. How to draw an ellipse?

. How to draw a rectangular shape?
. How to draw a regular polygon?

. How to draw a donut?
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Chapter 5
Editing the AutoCAD entities

Modify Objects

You can easily modify the size, shape, and location of objects. You can:
e Enter a command first, and then select the objects to modify.
Select the objects first, and then enter a command to modify them.

e Select and right-click an object to display a shortcut menu with relevant
options.

e Double-click an object to display the Properties palette or, in some cases, a
dialog box or editor that is specific to that type of object. (You can specify the double
click action for each object type by customizing a CUI file and loading it into the
program).

Select Objects

You have a wide range of options when you need to select objects for editing
operations.

Select Objects Individually

At the Select Objects prompt, you can select one or more objects individually.

Use the Pickbox Cursor

When the square pickbox cursor is in position to select an object, the object is
highlighted. Click to select the object (fig. 5.1).

You can control the size of the pickbox in the Options dialog box,
Selection tab.

Select Objects Close Together

It is difficult to select objects that are close together or lie directly on top of one
another. The example shows two lines and a circle that lie within the pickbox.
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Figure 5.1 — Select Objects Individually

58



If selection preview is turned on, you can cycle through the objects by rolling
over the object on top to highlight it, and pressing and holding SHIFT and
then pressing SPACEBAR continuously. When the required object is highlighted,
left-click to select it.

If selection preview is turned off, hold down SHIFT + SPACEBAR and click
to cycle through these objects, one after the other, until the one you want is selected.
Press ESC to turn off cycling.

Remove Selection from Objects

Remove objects from the current selection set by holding down SHIFT and
selecting them again.

Select Multiple Objects

At the Select Objects prompt, you can select many objects at the same time.

Specify a Rectangular Selection Area

Specify opposite corners to define a rectangular area. The background inside
the area changes color and becomes transparent. The direction that you drag your
cursor from the first point to the opposite corner determines which objects are
selected (fig. 5.2).

e Window selection. Drag your cursor from left to right to select only objects
that are entirely enclosed by the rectangular area.

e Crossing selection. Drag your cursor from right to left to select objects that
the rectangular window encloses or crosses.

With a window selection, usually the entire object must be contained in the
rectangular selection area. However, if an object with a noncontinuous (dashed)
linetype is only partially visible in the viewport and all the visible vectors of the
linetype can be enclosed within the selection window, the entire object is selected.

abjects selecied using window selection box
1

S AV
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Jbjects selacied usng Crossing seklecton Dox

Figure 5.2 — Select Multiple Objects
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Specify an Irregularly Shaped Selection Area

Specify points to define an irregularly shaped area. Use window polygon
selection to select objects entirely enclosed by the selection area. Use crossing
polygon selection to select objects enclosed or crossed by the selection area.

Specify a Selection Fence
In a complex drawing, use a selection fence. A selection fence looks like a polyline
and selects only the objects it passes through. The circuit board illustration shows a
fence selecting several components.

Use Other Selection Options

You can see all selection options by entering? at the Select Objects prompt. For
a description of each of the selection options, see SELECT.

Remove Selection from Multiple Objects

You can enter r (Remove) at the Select Objects prompt and use any selection
option to remove objects from the selection set. If you are using the Remove option
and want to return to adding objects to the selection set, enter a (Add).

You can also remove objects from the current selection set by holding down
SHIFT and selecting them again, or by holding down SHIFT and then clicking and
dragging window or crossing selections. You can add and remove objects repeatedly
from the selection set.

Correct Mistakes

You can backtrack your recent actions using one of several methods.

Undo a Single Action

The simplest method of backtracking is to use Undo on the Standard toolbar or
the U command to undo a single action. Many commands include their own U (undo)
option so that you can correct mistakes without leaving the command. When you are
creating lines and polylines, for example, enter u to undo the last segment.

Note. By default, the UNDO command is set to combine consecutive pan and
zoom commands into a single operation when you undo or redo. However, pan and
zoom commands that are started from the menu are not combined, and always remain
separate actions.

Undo Several Actions at Once

Use the Mark option of UNDO to mark an action as you work. You can then
use the Back option of UNDO to undo all actions that occurred after the marked
action. Use the Begin and End options of UNDO to define a set of actions to be
treated as a group.

You can also undo several actions at once with the Undo list on the Standard
toolbar.

Reverse the Effect of Undo

You can reverse the effect of a single U or UNDO command by using REDO
immediately after using U or UNDO.

You can also redo several actions at once with the Redo list on the Standard
toolbar.
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Erase Objects

You can erase any object that you draw. If you accidentally erase the wrong
object, you can use the UNDO command or the OOPS command to restore it.

Cancel a Command

You can cancel a command without completing it by pressing ESC.

Erase Objects

You can erase objects from your drawing using several methods.

e Erase them with ERASE,

e Select them and then cut them to the Clipboard with CTRL+X,

e Select them and press DELETE.

You can restore accidentally erased objects using UNDO. The OOPS
command restores all objects deleted by the most recent use of ERASE.

Toolbar: Modify -‘g

Menu: Modify» Erase

Shortcut menu: Select the objects to erase, right-click in the drawing area, and
click Erase.

Command entry: erase.

Clean Up the Display

You can remove the plus-shaped markers called blips and stray pixels that may
be left over from some editing operations from the display area.

e To remove blips, use REDRAW.

e To remove stray pixels, use REGEN.
Move Objects
You can move objects at a specified distance and direction from the originals.

Use coordinates, grid snap, object snaps, and other tools to move objects with
precision.

Toolbar: Modify ‘-I*

Menu: Modify » Move

Shortcut menu: Select the objects to move, and right-click in the drawing area.
Click Move.

Command entry: move.

Specify Distance with Two Points

Move an object using the distance and direction specified by a base point
followed by a second point. In this example, you move the block representing a
window. Click Edit menu » Move. Then select the object to be moved (1). Specify
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the base point for the move (2) followed by a second point (3). The object is moved
the distance and direction of point 2 to point 3 (fig. 5.3).
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Figure 5.3 — Move Objects

Specify Distance with Relative Coordinates

You can move an object using a relative distance by entering coordinate values
for the first point and pressing ENTER for the second point. The coordinate values
are used as a relative displacement rather than the location of a base point.

Note. Do not include an @ sign as you normally would for relative coordinates,
because relative coordinates are expected.

To copy objects a specified distance, you can also use direct distance entry
with Ortho mode and polar tracking. For more information, see Enter Direct
Distances.

Use a Stretch-Move

You can also use STRETCH to move objects if all their endpoints lie entirely
within the selection window. Turn on Ortho mode or polar tracking to move the
objects at a specific angle.

A practical example is moving a door in a wall (fig. 5.4). The door in the
illustration is entirely within a crossing selection, while the wall lines are only partly
within the crossing selection area.

3 A
objects selected with door moved with result
Crossing selection Ortho mode on and

direct distance antry

Figure 5.4 — Move the Door

The result is that only the endpoints that lie within the crossing selection move.
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Rotate Objects

You can rotate objects in your drawing around a specified base point.
To determine the angle of rotation, you can enter an angle value, drag using the
cursor, or specify a reference angle to align to an absolute angle.

Toolbar: Modify O

Menu: Modify» Rotate

Shortcut menu: Select the objects to rotate, and right-click in the drawing area.
Click Rotate.

Command entry: rotate.

Rotate an Object by a Specified Angle

Enter a rotation angle value from 0 to 360 degrees. You can also enter values in
radians, grads, or surveyor bearings. Entering a positive angle value rotates the
objects counterclockwise or clockwise, depending on the Direction Control setting in
the Drawing Units dialog box.

Rotate an Object by Dragging

Drag the object around the base point and specify a second point. Use Ortho
mode, polar tracking, or object snaps for greater precision.

For example, you can rotate the plan view of a house (fig. 5.5) by selecting the
objects (1), specifying a base point (2), and specifying an angle of rotation by
dragging to another point (3).

2
1
object selected base point and angle of result
rotation
Figure 5.5 — Rotate Objects
Rotate an Object to an Absolute Angle
With the Reference option, you can rotate an object to align it to an absolute
angle.

For example, to rotate the part in the illustration (fig. 5.6) so the diagonal
edge rotates to 90 degrees, you select the objects to be rotated (1, 2), specify the base
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point (3), and enter the Reference option. For the reference angle, specify the two
endpoints of the diagonal line (4, 5). For the new angle, enter 90.
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Figure 5.6 — Rotate Command Example

Scale Objects

You can enlarge or reduce selected objects proportionally in the X, Y, and Z
directions

Toolbar: Modify

Menu: Modify» Scale

Shortcut menu: Select the objects to scale, and right-click in the drawing area.
Click Scale.

Command entry: scale

Scale Objects Using a Scale Factor

With SCALE, you can make an object uniformly larger or smaller. To scale an
object, you specify a base point and a scale factor. Alternatively, you can specify a
length to be used as a scale factor based on the current drawing units.

A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1
shrinks the object (fig. 5.7).

Scaling changes the size of all dimensions of the selected object. A scale factor
greater than 1 enlarges the object. A scale factor less than 1 shrinks the object.

object selected abjzct scaled by faclor resut
0.5

Figure 5.7 — Scale Objects
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Note. When you use the SCALE command with annotative objects, the
position or location of the object is scaled relative to the base point of the scale
operation, but the size of the object is not changed.

Scale Objects Using a Reference Distance

You can also scale by reference. Scaling by reference uses an existing distance
as a basis for the new size. To scale by reference, specify the current distance and
then the new desired size. For example, if one side of an object is 4.8 units long and
you want to expand it to 7.5 units, use 4.8 as the reference length.

You can use the Reference option to scale an entire drawing. For example, use
this option when the original drawing units need to be changed. Select all objects in
the drawing. Then use Reference to select two points and specify the intended
distance. All the objects in the drawing are scaled accordingly.

Copy Objects

You can create duplicates of objects at a specified distance and direction from
the originals.

Use coordinates, grid snap, object snaps, and other tools to copy objects with
precision.

(G
Toolbar: Modify Q
Menu: Modify » Copy
Shortcut menu: Select the objects to copy, and right-click in the drawing area.

Click Copy Selection.

Command entry: copy

Specify Distance with Two Points

Copy an object using the distance and direction specified by a base point
followed by a second point (fig. 5.8). In this example, you copy the block
representing an electronic component.Click Edit menu » Copy.At the Command
prompt, enter copyclip. Then select the original object to be copied. Specify the base
point for the move (1) followed by a second point (2). The object is copied the

distance and direction of point 1 to point 2.

copy of object
original object -
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object selected result

Figure 5.8 — Copy Objects
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Specify Distance with Relative Coordinates

Copy an object using a relative distance by entering coordinate values for the
first point and pressing ENTER for the second point. The coordinate values are used
as a relative displacement rather than the location of a base point.

Note. Do not include an @ sign as you normally would for relative coordinates,
because relative coordinates are expected.

To copy objects a specified distance, you can also use direct distance entry
with Ortho mode and polar tracking. For more information, see Enter Direct
Distances.

Create Multiple Copies (fig. 5.9)

The COPY command repeats automatically by default. To exit the command,
press ENTER. To change the default, use the COPYMODE system variable.
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Figure 5.9 — Create Multiple Copies
Mirror Objects

You can flip objects about a specified axis to create a symmetrical mirror
image (fig. 5.10).

Mirroring is useful for creating symmetrical objects because you can quickly
draw half the object and then mirror it instead of drawing the entire object.

Toolbar: Modify Alh

Menu: Modify» Mirror

Command entry: mirror

You flip objects about an axis called a mirror line to create a mirror image. To
specify this temporary mirror line, you enter two points. You can choose whether to
erase or retain the original objects.
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Figure 5.10 — Mirror Objects

By default, when you mirror text, attributes, and attribute definitions, they are
not reversed or turned upside down in the mirror image. The text has the same
alignment and justification as before the object was mirrored. If you do want text to
be reversed, set the MIRRTEXT system variable to 1.

MIRRTEXT affects text that 1s created with the TEXT, ATTDEF, or MTEXT
commands; attribute definitions; and variable attributes. Text and constant attributes

that are part of an inserted block are reversed when the block is mirrored regardless
of the MIRRTEXT setting.

Create an Array of Objects

You can create copies of objects in a rectangular or polar (circular) pattern
called an array (fig. 5.11).

For rectangular arrays, you control the number of rows and columns and the
distance between each.

ODDOPr
' —distance between

ODDDﬁms

| |
1|O

= E

object selected | distance between columns

Figure 5.11 — Create a Rectangular Array of Objects

A rectangular array is built along a baseline defined by the current snap
rotation angle. This angle is zero by default, so the rows and columns of a rectangular
array are orthogonal with respect to the X and Y axes. The default angle 0 direction
setting can be changed in UNITS.
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For polar arrays (fig. 5.12), you control the number of copies of the object and
whether the copies are rotated. To create many regularly spaced objects, arraying is
faster than copying.

O ODQ 1
Q™ )o
Cao

polar array with objecis polar array angle to
rotated fill=180; objects not
rotated

Figure 5.12 — Create a Polar Array of Objects

a0

Toolbar: Modify ad

Menu: Modify» Array

Command entry: array

The Array dialog box is displayed. You can create rectangular or polar arrays
by choosing the appropriate option. Each object in an array can be manipulated
independently. If you select multiple objects, the objects are treated as one item to be
copied and arrayed.

If you enter -array at the command prompt, options are displayed at the
command prompt.

Use the Rectangular Array (fig. 5.13) option to create an array of rows and
columns of copies of the selected object. Use the Polar Array option to create an
array by copying the selected objects around a center point.

Other options: Select Objects, Preview Area, Preview.

Select Objects

Specifies the objects used to construct the array. You can select objects before
or after the Array dialog box is displayed. To select objects when the Array dialog
box is displayed, choose Select Objects. The dialog box temporarily closes. When
you finish selecting objects, press ENTER. The Array dialog box is redisplayed, and
the number of objects selected is shown below the Select Objects button.

Note. 1f you select multiple objects, the base point of the last selected object is
used to construct the array.

Preview Area

Shows a preview image of the array based on the current settings in the dialog
box. The preview image is dynamically updated when you move to another field after
changing a setting.
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Preview
Closes the Array dialog box and displays the array in the current drawing.
Choose Modify to return to the Array dialog box to make changes.

Rectangular Array
Creates an array of rows and columns of copies of the selected object.

© sctangular o O Polar Ay Selectotjects

[ objects zelected

Fiows: 4 Colurnnz: 4

Offzet digtance and direction
e e o o |

R offzet: 1 g g g g
e e e e |

Column offset: 1

Anagle of arraw: 1]

i !\,l By default, if the row offzet iz negative,

= rows are added downward. | the
column affset iz negative, columns are

TP added to the left

Help

Figure 5.13 — Rectangular Array Panel

Rows — specifies the number of rows in the array.

If you specify one row, you must specify more than one column. If you specify
a large number of rows and columns for the array, it might take a while to create the
copies. By default, the maximum number of array elements that you can generate in
one command is 100,000. The limit is set by the MAXARRAY setting in the registry.
To reset the limit to 200,000, for example, enter (setenv «MaxArray» «200000») at
the Command prompt.

Columns — specifies the number of columns in the array.

If you specify one column, you must specify more than one row. If you specify
a large number of rows and columns for the array, it might take a while to create the
copies. By default, the maximum number of array elements that you can generate in
one command is 100,000. The limit is set by the MAXARRAY setting in the registry.
To reset the limit to 200,000, for example, enter (setenv «MaxArray» «200000») at
the Command prompt.
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Offset Distance and Direction — provides a space for you to specify the
distance and direction of the array’s offset:

e Row Offset specifies the distance (in units) between rows. To add rows
downward, specify a negative value. To specify row spacing with the pointing device,
use the Pick Both Offsets button or the Pick Row Offset button.

e Column Offset specifies the distance (in units) between columns. To add
columns to the left, specify a negative value. To specify column spacing with the
pointing device, use the Pick Both Offsets button or the Pick Column Offset button.

o Angle of Array specifies the angle of rotation. This angle is normally 0, so
the rows and columns are orthogonal with respect to the X and Y drawing axes of the
current UCS. You can change the measurement conventions for angles using UNITS.
The ANGBASE and ANGDIR system variables affect the angle of arrays.

e Pick Both Offsets temporarily closes the Array dialog box so that you can
use the pointing device to set the row and column spacing by specifying two diagonal
corners of a rectangle.

e Pick Row Offset temporarily closes the Array dialog box so that you can
use the pointing device to specify the distance between rows. ARRAY prompts you
to specify two points and uses the distance and direction between the points to
specify the value in Row Offset.

e Pick Column Offset temporarily closes the Array dialog box so that you
can use the pointing device to specify the distance between columns. ARRAY
prompts you to specify two points and uses the distance and direction between the
points to specify the value in Column Offset.

e Pick Angle of Array temporarily closes the Array dialog box so that you
can specify the angle of rotation by entering a value or using the pointing device to
specify two points. You can change the measurement conventions for angles using
UNITS. The ANGBASE and ANGDIR system variables affect the angle of arrays.

Polar Array

Creates an array by copying the selected objects around a specified center point

Center Point

Specifies the center point of the polar array. Enter coordinate values for X
and Y, or choose Pick Center Point to use the pointing device to specify the location.

Pick Center Point

Temporarily closes the Array dialog box so that you can use the pointing
device to specify the center point in the drawing area.

Method and Values

Specifies the method and values used to position objects in the polar
array (fig. 5.14).

e Method sets the method used to position objects. This setting controls which
of the Method and Value fields are available for specifying values. For example, if
the method is Total Number of Items & Angle to Fill, the related fields are available
for specifying values; the Angle Between Items field is not available.
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e Total Number of Items sets the number of objects that appear in the
resultant array. The default value is 4.

o Angle to Fill sets the size of the array by defining the included angle
between the base points of the first and last elements in the array. A positive value
specifies counterclockwise rotation. A negative value specifies clockwise rotation.
The default value is 360. A value of 0 is not permitted.

e Angle Between Items sets the included angle between the base points of the
arrayed objects and the center of the array. Enter a positive value. The default
direction value is 90. You can choose the Pick buttons and use the pointing device to
specify the values for Angle to Fill and Angle Between Items.

T
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Figure 5.14 — Polar Array Panel

e Pick Angle to Fill temporarily closes the Array dialog box so that you can
define the included angle between the base points of the first and last elements in the
array. ARRAY prompts you to select a point relative to another point in the drawing
area.

e Pick Angle Between Items temporarily closes the Array dialog box so that
you can define the included angle between the base points of the arrayed objects and
the center of the array. ARRAY prompts you to select a point relative to another
point in the drawing area.
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Rotate Items as Copied

Rotates the items in the array, as shown in the preview area.

More/Less

Turns the display of additional options in the Array dialog box on and off.
When you choose More, additional options are displayed, and the name of this button
changes to Less.

Object Base Point

Specifies a new reference (base) point relative to the selected objects that will
remain at a constant distance from the center point of the array as the objects are
arrayed. To construct a polar array, ARRAY determines the distance from the array’s
center point to a reference (base) point on the last object selected. The point used
depends on the type of object.

e Arc, circle, ellipse — Center point.

e Polygon, rectangle — First corner.

e Donut, line, polyline — Starting point.

Set to Object’s Default

Uses the default base point of the object to position the arrayed object. To
manually set the base point, clear this option.

Base Point

Sets a new X and Y base point coordinate. Choose Pick Base Point to
temporarily close the dialog box and specify a point. After you specify a point, the
Array dialog box is redisplayed.

Note. To avoid unexpected results, set the base point manually if you are
constructing a polar array and do not want to rotate the objects.

Practical work

Purpose of work: entities creation skills developing, working with layers,
learning how to copy and remove objects, create objects arrays

Work order

Start AutoCAD and open the drawing tskl.dwg.
. Draw a summer theater plan.

2.1 Create a new layer.

2.2 Using the PLINE command (width 0), draw seats in form of a square with a
side of 1 m.

2.3 Using the ARRAY command (rectangular array), create a hall for an
audience: 15 rows of seats with 10 ones in each row. The distance between the rows
i1s 1 m, the distance between the seats is 0.1 m.

2.4 Create a new layer.

2.5 Using the PLINE command (width 0), draw a stage in a rectangular form.

3. Draw a summer circus plan.
3.1 Create a new layer for the seats of the circus.

N —
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3.2 Copy one of the seats into a free place.

3.3 Using the CHANGE command, carry a chair into the created layer.

3.4 Using the ARRAY (polar array) command, create a hall for an audience of
four identical sectors. In every sector there are 5 circular rows of seats. Passage-ways
are placed between the sectors. Pick the distance between the seats in a row and
between the rows yourself.

3.5 Create a new layer.

3.6 In the center of the circus draw an arena in a form of a circle.

4. Save the drawing in the personal folder and compress it (Zip).
5. Save this archive in the Academy distance learning system.

Basic theoretical information

Modify Objects

You can easily modify the size, shape, and location of objects. You can:

e Enter a command first, and then select the objects to modify.

Select the objects first, and then enter a command to modify them.

Select and right-click an object to display a shortcut menu with relevant

options.

e Double-click an object to display the Properties palette or, in some cases, a
dialog box or editor that is specific to that type of object. (You can specify the double
click action for each object type by customizing a CUI file and loading it into the
program.)

Select Objects

You have a wide range of options when you need to select objects for editing
operations.

Select Objects Individually. At the Select Objects prompt, you can select one
or more objects individually.

Use the Pickbox Cursor. When the square pickbox cursor is in position to
select an object, the object is highlighted. Click to select the object.

You can control the size of the pickbox in the Options dialog box, Selection tab.

Select Objects Close Together. It is difficult to select objects that are close
together or lie directly on top of one another. The example shows two lines and a
circle that lie within the pickbox.

If selection preview is turned on, you can cycle through the objects by rolling
over the object on top to highlight it, and pressing and holding SHIFT and then
pressing SPACEBAR continuously. When the required object is highlighted, left-
click to select it.

If selection preview is turned off, hold down SHIFT + SPACEBAR and click
to cycle through these objects, one after the other, until the one you want is selected.
Press ESC to turn off cycling.

Remove Selection from Objects.

Remove objects from the current selection set by holding down SHIFT and
selecting them again.
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Correct Mistakes

You can back track your recent actions using one of several methods.

Undo a Single Action. The simplest method of backtracking is to use Undo on
the Standard toolbar or the U command to undo a single action. Many commands
include their own U (undo) option so that you can correct mistakes without leaving
the command. When you are creating lines and polylines, for example, enter u to
undo the last segment. By default, the UNDO command is set to combine consecutive
pan and zoom commands into a single operation when you undo or redo. However,
pan and zoom commands that are started from the menu are not combined, and
always remain separate actions.

Undo Several Actions at Once. Use the Mark option of UNDO to mark an
action as you work. You can then use the Back option of UNDO to undo all actions
that occurred after the marked action. Use the Begin and End options of UNDO to
define a set of actions to be treated as a group.

You can also undo several actions at once with the Undo list on the Standard
toolbar.

Reverse the Effect of Undo. You can reverse the effect of a single U or
UNDO command by using REDO immediately after using U or UNDO.

You can also redo several actions at once with the Redo list on the Standard
toolbar.

Erase Objects. You can erase any object that you draw. If you accidentally
erase the wrong object, you can use the UNDO command or the OOPS command to
restore it.

Cancel a Command. You can cancel a command without completing it by
pressing ESC.

Erase Objects

You can erase objects from your drawing using several methods:

1. Erase them with ERASE;

2. Select them and then cut them to the Clipboard with CTRL+X;

3. Select them and press DELETE.

You can restore accidentally erased objects using UNDO. The OOPS
command restores all objects deleted by the most recent use of ERASE.

Clean Up the Display

You can remove the plus-shaped markers called blips and stray pixels that may
be left over from some editing operations from the display area.

e To remove blips, use REDRAW.

e To remove stray pixels, use REGEN.

Move Objects

You can move objects at a specified distance and direction from the originals.

Use coordinates, grid snap, object snaps, and other tools to move objects with
precision.

Move an object using the distance and direction specified by a base point
followed by a second point.

74



Rotate Objects

You can rotate objects in your drawing around a specified base point.

To determine the angle of rotation, you can enter an angle value, drag using the
cursor, or specify a reference angle to align to an absolute angle.

Rotate an Object by a Specified Angle. Enter a rotation angle value from 0 to
360 degrees. You can also enter values in radians, grads, or surveyor bearings.
Entering a positive angle value rotates the objects counterclockwise or clockwise,
depending on the Direction Control setting in the Drawing Units dialog box.

Rotate an Object by Dragging. Drag the object around the base point and
specify a second point. Use Ortho mode, polar tracking, or object snaps for greater
precision.

Scale Objects

With SCALE, you can make an object uniformly larger or smaller. To scale an
object, you specify a base point and a scale factor. Alternatively, you can specify a
length to be used as a scale factor based on the current drawing units.

A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1
shrinks the object.

Scaling changes the size of all dimensions of the selected object. A scale factor
greater than 1 enlarges the object. A scale factor less than 1 shrinks the object.

Copy Objects

You can create duplicates of objects at a specified distance and direction from
the originals.

Use coordinates, grid snap, object snaps, and other tools to copy objects with
precision.

Mirror Objects

You can flip objects about a specified axis to create a symmetrical mirror
image.

Mirroring is useful for creating symmetrical objects because you can quickly
draw half the object and then mirror it instead of drawing the entire object.

You flip objects about an axis called a mirror line to create a mirror image. To
specify this temporary mirror line, you enter two points. You can choose whether to
erase or retain the original objects.

By default, when you mirror text, attributes, and attribute definitions, they are
not reversed or turned upside down in the mirror image. The text has the same
alignment and justification as before the object was mirrored. If you do want text to
be reversed, set the MIRRTEXT system variable to 1.

Create an Array of Objects

You can create copies of objects in a rectangular or polar (circular) pattern
called an array.

For rectangular arrays, you control the number of rows and columns and the
distance between each.

A rectangular array is built along a baseline defined by the current snap
rotation angle. This angle is zero by default, so the rows and columns of a rectangular
array are orthogonal with respect to the X and Y axes. The default angle 0 direction
setting can be changed in UNITS.
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For polar arrays, you control the number of copies of the object and whether
the copies are rotated. To create many regularly spaced objects, arraying is faster than

copying.

XA B =

Self-examination questions

Selecting objects.

Object Selection Options.

Commands for selecting objects.

Selecting objects based on common properties.
Selecting overlapping or closely spaced objects.
Copying objects.

Multiple copies in any editing mode.
Commands for copying objects.

Create multiple copies.

. Create an object based on the selected object.

. Moving Objects.

. Moving an object to a specified offset value.

. Moving an object by two points.

. Moving objects using the Stretch command.

. Commands for transferring and rotating objects.
. Align objects.

. Rotate objects.

. Rotate an object to the specified absolute angle.
. Commands for transferring and rotating objects.
. Arrays of objects.

. Working with circular arrays.

. Working with rectangular arrays.

. Commands for working with arrays.
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Chapter 6
Changing the properties of the AutoCAD
entities

Overview of Object Properties

Every object you draw has properties. Some properties are general and apply to
most objects; for example, layer, color, linetype, and plot style. Other properties are
object-specific; for example, the properties of a circle include radius and area, and the
properties of a line include length and angle.

Most general properties can be assigned to an object by layer or can be
assigned to an object directly:

e When a property is set to the value BYLAYER, the object is assigned the
same value as the layer on which it is drawn. For example, if a line drawn on LayerQ
is assigned the color BYLAYER, and Layer( is assigned the color Red, the line is
red.

e When a property is set to a specific value, that value overrides the value set
for the layer. For example, if a line drawn on Layer0 is assigned the color Blue, and
LayerO is assigned the color Red, the line is blue.

There are eight general properties common to all objects. All other object
properties are specific to the type of object.

The following general properties are common to most objects and custom
objects (third-party application objects based on AutoCAD API standards).

Color

Specifies the color for objects. Selecting Select Color in the color list displays
the Select Color dialog box (see COLOR).

You can use the Select Color dialog box to define the color of objects by
selecting from the 255 AutoCAD Color Index (ACI) colors, true colors, and color
book colors.

Layer

Specifies the current layer of the object. The list shows all layers in the current
drawing (see LAYER).

Linetype

Specifies the current linetype of the object. The list shows all linetypes in the
current drawing (see LINETYPE).

Linetype Scale

Specifies the linetype scale factor of the object (see LTSCALE).

Plot Style

Lists NORMAL, BYLAYER, BYBLOCK, plus any plot styles contained in the
current plot style table (see PLOTSTYLE).
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Lineweight

Specifies the lineweight of the object. The list shows all available lineweights

in the current drawing (see LWEIGHT).

Hyperlink

Attaches a hyperlink to a graphical object. If a description has been assigned to
the hyperlink, the description is displayed. If no description has been assigned, the
URL is displayed (see HYPERLINK).

Thickness (fig. 6.1)

Sets the current 3D thickness. This property does not apply to all objects (see

CHPROP).

P
.

thickness samples

Figure 6.1 — Thickness Property
The PROPERTIES command controls properties of existing objects

Er
Toolbar: Standard LZ
Menu: Modify» Properties.

Shortcut menu: Select the objects whose properties you want to view or
modify, right-click in the drawing area, and click Properties.

Command entry: properties

The Properties palette is displayed (fig. 6.2). The Properties palette lists

properties of the selected object or set of objects.
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Figure 6.2 — Properties Palette
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You can also view or modify properties of third-party application objects that
are based on AutoCAD application programming interface (API) standards.

The Properties palette lists the current settings for properties of the selected
object or set of objects. You can modify any property that can be changed by
specifying a new value.

e When more than one object is selected, the Properties palette displays only
those properties common to all objects in the selection set.

e When no objects are selected, the Properties palette displays only the general
properties of the current layer, the name of the plot style table attached to the layer,
the view properties, and information about the UCS.

You can double-click most objects to open the Properties palette when the
DBLCLKEDIT system variable is on (the default). The exceptions include blocks
and attributes, hatches, gradient fills, text, multilines, and xrefs. If you double-click
any of these objects, an object-specific dialog box displays instead of the Properties
palette.

Copy Properties Between Objects

You can copy some or all properties of one object to other objects using Match
Properties (fig. 6.3).

The types of properties that can be copied include, but are not limited to, color,
layer, linetype, linetype scale, lineweight, plot style, viewport property overrides, and
3D thickness.

By default, all applicable properties are automatically copied from the first
object you selected to the other objects. If you don’t want a specific property or
properties to be copied, use the Settings option to suppress the copying of that
property. You can choose the Settings option at any time during the command.
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Figure 6.3 — Copy Properties Between Objects
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The MATCHPROP command applies the properties of a selected object to
other objects.

A

Toolbar: Standard s

Menu: Modify» Match Properties

Command entry: matchprop.

Destination Object(s)

Specifies the objects to which you want to copy the properties of the source
object. You can continue selecting destination objects, or press ENTER to apply the
properties and end the command.

Settings

Displays the Property Settings dialog box (fig. 6.4), in which you can control
which object properties to copy to the destination objects. By default, in the Property
Settings dialog box all object properties are selected for copying.

'#: Property Settings

Bazic Properties

Color . Byl ayer . .
Layper 3

Linetype Byl ayer

Linetype Scale 1
Linewseight 0.00
Thickness 0

Special Properties
Dimenzian Tent Hatch
FPalyline Wigwwport

Figure 6.4 — Property Settings Dialog Box

Color changes the color of the destination object to that of the source object.
Available for all objects.

Layer changes the layer of the destination object to that of the source object.
Available for all objects.

Linetype changes the linetype of the destination object to that of the source
object. Available for all objects except attributes, hatches, multiline text, points, and
viewports.

Linetype Scale changes the linetype scale factor of the destination object to that
of the source object. Available for all objects except attributes, hatches, multiline
text, points, and viewports.
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Lineweight changes the lineweight of the destination object to that of the
source object. Available for all objects.

Thickness changes the thickness of the destination object to that of the source
object. Available only for arcs, attributes, circles, lines, points, 2D polylines, regions,
text, and traces.

Plot Style changes the plot style of the destination object to that of the source
object. If you are working in color-dependent plot style mode (PSTYLEPOLICY is
set to 1), this option is unavailable. Available for all objects, except those with the
Jitter edge modifier applied.

Polyline. In addition to basic object properties, changes the width and linetype
generation properties of the destination polyline to those of the source polyline. The
fit/smooth property and the elevation of the source polyline are not transferred to the
destination polyline. If the source polyline has variable width, the width property is
not transferred to the destination polyline.

Control the Display Properties of Certain Objects

Turn Off Solid Fill

When you turn off Fill mode, wide polylines, solid-filled polygons, gradient
fill, and hatches are displayed in outline form (fig. 6.5). Except for patterned hatches
and gradient fills, solid fill is automatically turned off for hidden view and nonplan
views in three dimensions.

F Il mode on Fill mode aff

Figure 6.5 — Solid Fill Mode

Use Quick Text

When you turn on Quick Text mode in drawings that contain a lot of text using
complex fonts, only a rectangular frame defining the text is displayed or plotted.

Turn Off Lineweights

Any lineweight width that is represented by more than one pixel may slow
down performance. If you want to improve display performance, turn lineweights off.
You can turn lineweights on and off by choosing the LWT button on the status bar or
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by using the Lineweight Settings dialog box. Lineweights are always plotted at their
real-world value whether their display is turned on or off.

Update the Display

New objects automatically use the current settings for displays of solid fill and
text. Except for lineweights, to update the display of existing objects using these
settings, you must use REGEN.

Practical work

Purpose: skills of entities creating and editing developing, working with
layers, learning to change the properties of objects

Work order

Start AutoCAD and open the drawing tsk1.dwg.

Create a new layer PLANIT.

Copy all the drawing objects into a free area.

Remove the copy of all the drawing objects into the layer PLANI.

5. On every object in the layer PLANI1, change the COLOR property (this
property of all the objects must have the 1n1t1a1 value BYLAYER). The color of
every object must correspond to the color of the layer in which this object has been
created in.

6. Think over the layout of the objects in the park.

7. Using the MOVE command, put the stadium, the theater and the circus
into proper places.

8. Place a few booths and flowerbeds into the park.

9. Using polylines of different widths, draw avenues, roads and paths.

10. Create a new layer PLAN2.

11. Copy all the objects of the layer PLANI into a free area.

12. Remove the objects copies into the layer PLAN2.

13. Create a new variant of the park planning (pp. 6-9).

14. Save the drawing in the personal folder and compress it (Zip).

Save this archive in the Academy distance learning system.

b

Basic theoretical information

Object Properties

Every object you draw has properties. Some properties are general and apply to
most objects; for example, layer, color, linetype, and plot style. Other properties are
object-specific; for example, the properties of a circle include radius and area, and the
properties of a line include length and angle.
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Most general properties can be assigned to an object by layer or can be
assigned to an object directly:

e When a property is set to the value BYLAYER, the object is assigned the
same value as the layer on which it is drawn. For example, if a line drawn on LayerQ
is assigned the color BYLAYER, and Layer( is assigned the color Red, the line is
red.

e When a property is set to a specific value, that value overrides the value set
for the layer. For example, if a line drawn on LayerO is assigned the color Blue, and
LayerO is assigned the color Red, the line is blue.

Copy Properties Between Objects

You can copy some or all properties of one object to other objects using Match
Properties.

The types of properties that can be copied include, but are not limited to, color,
layer, linetype, linetype scale, lineweight, plot style, viewport property overrides,
and 3D thickness.

By default, all applicable properties are automatically copied from the first
object you selected to the other objects. If you don’t want a specific property or
properties to be copied, use the Settings option to suppress the copying of that
property. You can choose the Settings option at any time during the command.

Control the Display Properties of Certain Objects

When you turn off Fill mode, wide polylines, solid-filled polygons, gradient
fill, and hatches are displayed in outline form. Except for patterned hatches and
gradient fills, solid fill is automatically turned off for hidden view and nonplan views
in three dimensions.

When you turn on Quick Text mode in drawings that contain a lot of text using
complex fonts, only a rectangular frame defining the text is displayed or plotted.

Any lineweight width that is represented by more than one pixel may slow
down performance. If you want to improve display performance, turn lineweights off.
You can turn lineweights on and off by choosing the LWT button on the status bar or
by using the Lineweight Settings dialog box. Lineweights are always plotted at their
real-world value whether their display is turned on or off.

New objects automatically use the current settings for displays of solid fill and
text. Except for lineweights, to update the display of existing objects using these
settings, you must use REGEN.

Self-examination questions

1. Object Properties.

2. Property Color.

3. Propert Layer.

4. Propert Linetype.

5. Propert Linetype Scale.
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9

10.
1.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.

Propert Plot Style.

Propert Lineweight.

Propert Hyperlink.

PropertThickness.

Copy Properties Between Objects.

Elements of the drawing: layers, entities, blocks, views.

Parameters and properties of drawing elements.

Layer properties.

Ways to create layers.

Manage layers.

Features of the zero layer.

Preparation for drawing.

Selection of the current layer, color, line type and other parameters.
Methods and techniques of drawing entities.

When objects on a layer are visible or dimmed in any viewports

When and how objects are plotted.

What color is assigned to all objects on a layer.

What default linetype and lineweight are assigned to all objects on a layer.
When objects on a layer can be modified

Whether objects display with different layer properties in individual layout

viewports.

26.

Why layer 0 cannot be deleted or renamed.
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Chapter 7
Geometrical constructing with the use of
Object Snap

Use Precision Tools

You can use a variety of precision drawing tools to help you produce accurate
drawings quickly and without performing tedious calculations.

You can use Drafting Settings Dialog Box (fig. 7.1) that specifies drafting
settings organized for drawing aids in four categories: Snap and Grid, Polar Tracking,
Object Snap, and Dynamic Input.

@Dr&fﬁng Settings

Snap and Grid  Polar Tracking Obiect Snap  Dynamic Input

[¥] Obiect Snap On (F3) [ Obiect Snap Tracking On (F11)

Object Snap modes

O [7] Endpoint @ [lnsertion
A [¥]Midpoint b [ Perpendicular Clear Al

O [ Center T [ Tangent

2 [INode X [INearest

&[] Quadrant 1 Apparent intersection

X [ Intersection % [1Paalel

= [_] Extension

N To track from an Dgnap point, pause over the point while in a
5 command. A backing vector appears when you move the cursor,
To stop hacking. pause over the point again.

e I cocat L Heb, ]

Figure 7.1 — Drafting Settings Dialog Box
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Menu: Tools » Drafting Settings

Shortcut menu: Right-click Snap, Grid, Polar, Osnap, Otrack, or Dyn on the
status bar and click Settings.

Command entry: dsettings (or ‘dsettings for transparent use).

Snap and Grid

To enhance drawing speed and efficiency, you can display and snap to a
rectangular grid. You can also control its spacing, angle, and alignment.

The grid is a rectangular pattern of dots or lines that extends over the area you
specify as the grid limits. Using the grid is similar to placing a sheet of grid paper
under a drawing. The grid helps you align objects and visualize the distances between
them. The grid is not plotted.

Snap mode restricts the movement of the crosshairs to intervals that you define.
When Snap mode is on, the cursor seems to adhere, or «snap,» to an invisible
rectangular grid. Snap is useful for specifying precise points with the arrow keys or
the pointing device.

Grid mode and Snap mode are independent but are often turned on at the same
time.

Control the Display Style and Area of the Grid

You can display the grid either as a rectangular pattern of dots or as rectangular
pattern of lines (fig. 7.2). The grid displays dots only when the current visual style is
set to 2D Wireframe, otherwise the grid displays lines. A lined grid is displayed for
all visual styles while working in 3D. There are several methods to change the current
visual style, including the VSCURRENT command.

|

|
SR R EEE B
@t& "*%’f{f
A B [ 11 '

Visual styles = 2D Visual styles = hidden
wireframe

Figure 7.2 — Visual Styles
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By default, the X and Y axes of the UCS display in a different color than the
grid lines. You can control the color in the Drawing Window Colors dialog box. This
dialog box is accessible from the Drafting tab in the Options dialog box.

The LIMITS command controls the drawing area covered by the grid. As an
option, you can override the limits to make the grid cover the entire XY plane of the
user coordinate system (UCS). You can access this option in the Drafting Settings
dialog box or use the GRIDDISPLAY system variable.

Note. When you use dynamic UCS, the grid limits are set automatically relative
to the size of the selected face of the solid and the drawing area available.

Control the Frequency of Major Grid Lines

If the grid is displayed as lines rather than dots (fig. 7.3), darker lines called
major grid lines display at intervals. When working in decimal units or with feet and
inches, major grid lines are especially useful for measuring distances quickly. You
can control the frequency of major grid lines in the Drafting Settings dialog box.

To turn off the display of major grid lines, set the frequency of major grid
lines to 1.

Note. If the grid is displayed as lines, the grid limits are displayed also as
darker lines. Do not confuse these boundaries with major grid lines.

Note. When the grid is displayed as lines and SNAPANG is set to a value other
than 0, the grid will not display. SNAPANG does not affect the display of the dotted
grid.

grid limits

mincr grid lings——

major grid lings———

grid limits

minor grid lines

majer grid lines

Gridmajor = 5 Gridmajor =12

Figure 7.3 — Display Grid
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Change the Grid Dynamically During Zooming

If you zoom in or out of your drawing, the grid spacing is adjusted
automatically to be more appropriate for the new magnification. This is called
adaptive grid display.

For example, if you zoom way out, the density of displayed grid lines reduces
automatically. Conversely, if you zoom way in, additional grid lines display in the
same proportion as the major grid lines.

Change Grid and Snap Spacing

As you work, you can turn Grid and Snap mode on and off, and you can
change the grid and snap spacing. You can turn Snap mode on and off temporarily by
using an override key.

Snap spacing does not have to match grid spacing. For example, you might set
a wide grid spacing to be used as a reference but maintain a closer snap spacing for
accuracy in specifying points.

Change the Grid and Snap Angle and Base

If you need to draw along a specific alignment or angle, you can change the
grid and snap angle by rotating the user coordinate system (UCS) (fig. 7.4). This
rotation realigns the crosshairs on the screen to match the new angle. In the following
example, the UCS is rotated 30 degrees to match the angle of the anchor bracket.

UCS rotated O degrees LUCS rotated 30
degrees

Figure 7.4 — Grid and Snap Angle and Base

The grid and snap points are always aligned with the UCS origin. If you need
to shift the grid and grid snap origin, move the UCS.

Snap and Grid Tab (Drafting Settings Dialog Box) specifies Snap and Grid
settings.
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Snap On

Turns Snap mode on or off. You can also turn Snap mode on or off by clicking
Snap on the status bar, by pressing F9, or by using the SNAPMODE system variable.

Snap Spacing

Controls an invisible, rectangular grid of snap locations that restricts cursor
movement to specified X and Y intervals.

Snap X Spacing specifies the snap spacing in the X direction. The value must
be a positive real number. (SNAPUNIT system variable).

Snap Y Spacing specifies the snap spacing in the Y direction. The value must
be a positive real number. (SNAPUNIT system variable).

Equal X and Y Spacing forces the X and Y spacing to the same values for snap
spacing and for grid spacing. The snap spacing intervals can be different from the
grid spacing intervals.

Polar Spacing

Controls the PolarSnap increment distance.

Polar Distance sets the snap increment distance when PolarSnap is selected
under Snap Type & Style. If this value is 0, the PolarSnap distance assumes the value
for Snap X Spacing. The Polar Distance setting is used in conjunction with polar
tracking and/or object snap tracking. If neither tracking feature is enabled, the Polar
Distance setting has no effect. (POLARDIST system variable).

Snap Type

Sets the snap style and snap type.

Grid Snap sets the snap type to Grid. When you specify points, the cursor
snaps along vertical or horizontal grid points. (SNAPTYPE system variable).

Rectangular Snap sets the snap style to standard Rectangular snap mode. When
the snap type is set to Grid snap and Snap mode is on, the cursor snaps to a
rectangular snap grid. (SNAPSTYL system variable).

Isometric Snap sets the snap style to [sometric snap mode. When the snap type
is set to Grid snap and Snap mode is on, the cursor snaps to an isometric snap grid.
(SNAPSTYL system variable).

PolarSnap sets the snap type to Polar. When Snap mode is on and you specify
points with polar tracking turned on, the cursor snaps along polar alignment angles
set on the Polar Tracking tab relative to the starting polar tracking point.
(SNAPTYPE system variable).

Grid On

Turns the grid on or off. You can also turn grid mode on or off by clicking Grid
on the status bar, by pressing F7, or by using the GRIDMODE system variable.
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Grid Spacing

Controls the display of a grid that helps you visualize distances.

Note. The limits of the grid are controlled by the LIMITS command and the
GRIDDISPLAY system variable.

Grid X Spacing specifies the grid spacing in the X direction. If this value is 0,
the grid assumes the value set for Snap X Spacing (GRIDUNIT system variable).

Grid Y Spacing specifies the grid spacing in the Y direction. If this value is 0,
the grid assumes the value set for Snap Y Spacing (GRIDUNIT system variable).

Major Line Every specifies the frequency of major grid lines compared to
minor grid lines. Grid lines rather than grid dots are displayed when the
VSCURRENT is set to any visual style except 2D Wireframe (GRIDMAJOR system
variable).

Grid Behavior

Controls the appearance of the grid lines that are displayed when
VSCURRENT is set to any visual style except 2D Wireframe.

Adaptive Grid limits the density of the grid when zoomed out.
(GRIDDISPLAY system variable).

Allow Subdivision Below Grid Spacing generates additional, more closely
spaced grid lines when zoomed in. The frequency of these grid lines is determined by
the frequency of the major grid lines. (GRIDDISPLAY and GRIDMAJOR system
variables).

Display Grid Beyond Limits displays the grid beyond the area specified by the
LIMITS command. (GRIDDISPLAY system variable).

Follow Dynamic UCS changes the grid plane to follow the XY plane of the
dynamic UCS. (GRIDDISPLAY system variable).

Polar Tracking

Polar tracking (fig. 7.5) restricts cursor movement to specified angles.
PolarSnap restricts cursor movement to specified increments along a polar angle.

When you are creating or modifying objects, you can use polar tracking to
display temporary alignment paths defined by the polar angles you specify. In 3D
views, polar tracking additionally provides an alignment path in the up and down
directions. In that case, the tooltip displays a +Z or -Z for the angle.

Polar angles are relative to the orientation of the current user coordinate system
(UCS) and the setting for the base angle convention in a drawing. The angle base
direction is set in the Drawing Units dialog box.

Use PolarSnap to snap to specified distances along the alignment path. For
example, in the following illustration you draw a two-unit line from point 1 to point
2, and then draw a two-unit line to point 3 at a 45-degree angle to the line. If you turn
on the 45-degree polar angle increment, an alignment path and tooltip are displayed
when your cursor crosses the 0 or 45-degree angle. The alignment path and tooltip
disappear when you move the cursor away from the angle.
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tooltip display of
distance and angle

Figure 7.5 — Polar Tracking

As you move your cursor, alignment paths and tooltips are displayed when you
move the cursor near polar angles. The default angle measurement is 90 degrees. Use
the alignment path and tooltip to draw your object. You can use polar tracking with
Intersection and Apparent Intersection object snaps to find where a polar alignment
path intersects another object.

Note. Ortho mode and polar tracking cannot be on at the same time. Turning on
polar tracking turns off Ortho mode. Similarly, PolarSnap and grid snap cannot be on
at the same time. Turning on PolarSnap turns off grid snap.

Specify Polar Angles (Polar Tracking)

You can use polar tracking to track along polar angle increments of 90, 60, 45,
30, 22.5, 18, 15, 10, and 5 degrees, or you can specify other angles.

The orientation of 0 depends on the angle you set in the Drawing Units dialog
box (UNITS). The direction of snap (clockwise or counterclockwise) depends on the
units direction you specify when setting units of measurement.

You can turn polar tracking on and off temporarily by using an override key.
The direct distance entry method is not available while you are using the temporary
override key for polar tracking.

Specify Polar Distances (PolarSnap)

PolarSnap restricts cursor movement to increments of a polar distance you
specify. For example, if you specify a length of 4 units, the cursor snaps from the first
point specified to lengths of 0, 4, 8, 12, 16, and so on. As you move your cursor, a
tooltip indicates the nearest PolarSnap increment. To restrict point entry to polar
distances, both polar tracking and Snap mode (set to PolarSnap) must be on. You can
turn off all snapping and tracking temporarily by using an override key.

Polar Tracking Tab (Drafting Settings Dialog Box) controls the AutoTrack
settings.
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Polar Tracking On

Turns polar tracking on and off. You can also turn polar tracking on or off by
pressing F10 or by using the AUTOSNAP system variable.

Polar Angle Settings

Sets the alignment angles for polar tracking. (POLARANG system variable)

Increment Angle sets the polar increment angle used to display polar tracking
alignment paths. You can enter any angle, or select a common angle of 90, 45, 30,
22.5, 18,15, 10, or 5 degrees from the list. (POLARANG system variable).

Additional Angles makes any additional angles in the list available for polar
tracking. The Additional Angles check box is also controlled by the POLARMODE
system variable, and the list of additional angles is also controlled by the
POLARADDANG system variable.

Note. Additional angles are absolute, not incremental.

List of Angles if Additional Angles is selected, lists the additional angles that
are available. To add new angles, click New. To remove existing angles, click Delete.
(POLARADDANG system variable).

New adds up to 10 additional polar tracking alignment angles.

Note. Before adding fractional angles, you must set the AUPREC system
variable to the appropriate decimal precision to avoid undesired rounding. For
example, if the value of AUPREC is 0 (the default value), all fractional angles you
enter are rounded to the nearest whole number.

Delete deletes selected additional angles.

Object Snap Tracking Settings.

Sets options for object snap tracking.

Track Orthogonally Only displays only orthogonal (horizontal/vertical) object
snap tracking paths for acquired object snap points when object snap tracking is on.
(POLARMODE system variable)

Track Using All Polar Angle Settings applies polar tracking settings to object
snap tracking. When you use object snap tracking, the cursor tracks along polar
alignment angles from acquired object snap points. (POLARMODE system variable)

Note. Clicking Polar and Otrack on the status bar also turns polar tracking and
object snap tracking on and off.

Polar Angle Measurement

Sets the basis by which polar tracking alignment angles are measured.

Absolute bases polar tracking angles on the current user coordinate system
(UCS).

Relative to Last Segment bases polar tracking angles on the last segment
drawn.

Object Snap
Use object snaps to specify precise locations on objects. For example, you can

use an object snap to draw a line to the center of a circle or to the midpoint of a
polyline segment (fig. 7.6).
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You can specify an object snap whenever you are prompted for a point. By
default, a marker and a tooltip are displayed when you move the cursor over an object
snap location on an object. This feature, called AutoSnap™, provides a visual clue
that indicates which object snaps are in effect.

Midpaink

Figure 7.6 — Object Snap
Specify an Object Snap

To specify an object snap at a prompt for a point, you can:

e Press SHIFT and right-click to display the Object Snap shortcut menu.

e C(lick an object snap button on the Object Snap toolbar.

e Enter the name of an object snap at the command prompt.

When you specify an object snap at a prompt for a point, the object snap stays
in effect only for the next point that you specify.

Note. Object snaps work only when you are prompted for a point. If you try to
use an object snap at the Command prompt, an error message is displayed.

Use Running Object Snaps

If you need to use one or more object snaps repeatedly, you can turn on
running object snaps. For example, you might set Center as a running object snap if
you need to connect the centers of a series of circles with a line.

You can specify one or more running object snaps on the Object Snaps tab in
the Drafting Settings dialog box, which is accessible from the Tools menu. If several
running object snaps are on, more than one object snap may be eligible at a given
location. Press TAB to cycle through the possibilities before you specify the point.

Click the OSNAP button on the status bar or press F3 to turn running object
snaps on and off.

Note. 1f you want object snaps to ignore hatch objects, set the OSOPTIONS
system variable to 1.

Object Snap Tab (Drafting Settings Dialog Box) controls running object snap
settings.
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With running object snap settings, also called Osnap, you can specify a snap
point at an exact location on an object. When more than one option is selected, the
selected snap modes are applied to return a point closest to the center of the aperture
box. Press TAB to cycle through the options.

Object Snap On

Turns running object snaps on and off. The object snaps selected under Object
Snap Modes are active while object snap is on. (OSMODE system variable).

Object Snap Tracking On

Turns object snap tracking on and off. With object snap tracking, the cursor
can track along alignment paths based on other object snap points when specifying
points in a command. To use object snap tracking, you must turn on one or more
object snaps. (AUTOSNAP system variable).

Object Snap Modes

Lists object snaps that you can turn on as running object snaps.

Endpoint (fig. 7.7) snaps to the closest endpoint of an arc, elliptical arc, line,
multiline, polyline segment, spline, region, or ray, or to the closest corner of a trace,

solid, or 3D face.
selection poim \ //

snap point -

Figure 7.7 — Endpoint

Midpoint (fig. 7.8) snaps to the midpoint of an arc, ellipse, elliptical arc, line,
multiline, polyline segment, region, solid, spline, or xline.

selzction point—, ﬁ

- ‘snap pont

Figure 7.8 — Midpoint

Center (fig. 7.9) snaps to the center of an arc, circle, ellipse, or elliptical arc.
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selection point snap paint

Figure 7.9 — Center
Node snaps to a point object, dimension definition point, or dimension text
origin.
Quadrant (fig. 7.10) snaps to a quadrant point of an arc, circle, ellipse, or
elliptical arc.

snap pont——:

geechizn point |

Figure 7.10 — Quadrant
Intersection (fig. 7.11) snaps to the intersection of an arc, circle, ellipse,
elliptical arc, line, multiline, polyline, ray, region, spline, or xline. Extended
Intersection is not available as a running object snap.

Intersection and Extended Intersection do not work with edges or corners of 3D
solids.

—
— '
/
s

Figure 7.11 — Intersection

Note. You might get varying results if you have both the Intersection and
Apparent Intersection running object snaps turned on at the same time.
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Extension causes a temporary extension line or arc to be displayed when you
pass the cursor over the endpoint of objects, so you can specify points on the
extension.

Note. When working in perspective view, you cannot track along the extension
line of an arc or elliptical arc.

Insertion snaps to the insertion point of an attribute, a block, a shape, or text.

Perpendicular snaps to a point perpendicular to an arc, circle, ellipse, elliptical
arc, line, multiline, polyline, ray, region, solid, spline, or xline. Deferred
Perpendicular snap mode is automatically turned on when the object you are drawing
requires that you complete more than one perpendicular snap. You can use a line, arc,
circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to
draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular
lines between such objects. When the aperture box passes over a Deferred
Perpendicular snap point, an AutoSnap tooltip and marker are displayed.

Tangent snaps to the tangent of an arc, circle, ellipse, elliptical arc, or spline.
Deferred Tangent snap mode is automatically turned on when the object you are
drawing requires that you complete more than one tangent snap. You can use
Deferred Tangent to draw a line or xline that is tangent to arcs, polyline arcs, or
circles. When the aperture box passes over a Deferred Tangent snap point, a marker
and an AutoSnap tooltip are displayed.

Note. When you use the From option in conjunction with the Tangent snap mode to
draw objects other than lines from arcs or circles, the first point drawn is tangent to
the arc or circle in relation to the last point selected in the drawing area.

Nearest snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line,
multiline, point, polyline, ray, spline, or xline.

Apparent Intersection snaps to the visual intersection of two objects that are
not in the same plane but may appear to intersect in the current view. Extended
Apparent Intersection is not available as a running object snap. Apparent and
Extended Apparent Intersection do not work with edges or corners of 3D solids.

Note. You might get varying results if you have both the Intersection and
Apparent Intersection running object snaps turned on at the same time.

Parallel constrains a line segment, polyline segment, ray or xline to be parallel
to another linear object. After you specify the first point of a linear object, specify the
parallel object snap. Unlike other object snap modes, you move the cursor and hover
over another linear object until the angle is acquired. Then, move the cursor back
toward the object that you are creating. When the path of the object is parallel to the
previous linear object, an alignment path is displayed, which you can use to create the
parallel object.

Note. Turn off ORTHO mode before using the parallel object snap. Object snap
tracking and polar snap are turned off automatically during a parallel object snap
operation. You must specify the first point of a linear object before using the parallel
object snap.

96



Dynamic Input

Dynamic Input provides a command interface near the cursor to help you keep
your focus in the drafting area.

When Dynamic Input is on, tooltips display information near the cursor that is
dynamically updated as the cursor moves. When a command is active, the tooltips
provide a place for user entry.

After you type a value in an input field and press TAB, the field then displays a
lock icon, and the cursor is constrained by the value that you entered. You can then
enter a value for the second input field. Alternately, if you type a value and press
ENTER, the second input field is ignored and the value is interpreted as direct
distance entry.

The actions required to complete a command or to use grips are similar to those
for the command prompt. The difference is that your attention can stay near the
Cursor.

Dynamic Input is not designed to replace the command window. You can hide
the command window to add screen area for drawing, but you will need to display it
for some operations. Press F2 to hide and display command prompts and error
messages as needed. Alternately, you can undock the command window and use
Auto-hide to roll open or roll up the window.

Turn Dynamic Input On and Off

Click Dyn on the status bar to turn Dynamic Input on and off. You can turn it
off temporarily by holding down the F12 key. Dynamic Input has three components:
pointer input, dimensional input, and dynamic prompts. Right-click Dyn and click
Settings to control what is displayed by each component when Dynamic Input is on.

Pointer Input

When pointer input (fig. 7.12) is on and a command is active, the location of
the crosshairs is displayed as coordinates in a tooltip near the cursor. You can enter
coordinate values in the tooltip instead of on the command line.

The default for second and subsequent points is relative polar coordinates
(relative Cartesian for RECTANG). There is no need to type the at sign (@). If you
want to use absolute coordinates, use the pound sign (#) prefix. For example, to move
an object to the origin, for the second point prompt, enter #0,0.

Use the pointer input settings to change the default format for coordinates and
to control when pointer input tooltips are displayed.
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Fointer [nput

[ Settings...

Figure 7.12 — Pointer input
Dimensional Input

When dimensional input (fig. 7.13) is on, the tooltips display distance and
angle values when a command prompts for a second point. The values in the
dimensional tooltips change as you move the cursor. Press TAB to move to the value
you want to change. Dimensional input is available for ARC, CIRCLE, ELLIPSE,
LINE, and PLINE.

Dirmenzion [nput

Sethings...

Figure 7.13 — Dimension Input

When you use grips to edit an object, the dimensional input tooltips can display
the following information:
Original length
A length that updates as you move the grip
The change in the length
Angle
The change in the angle as you move the grip
The radius of an arc.
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— length change

absolute angle

Figure 7.14 — Dynamic Input

Use the dimensional input settings to display only the information you
want to see.

When you use grips to stretch objects or when you create new objects,
dimensional input displays only acute angles, that is, all angles are displayed as 180
degrees or less. Thus, an angle of 270 degrees is displayed as 90 degrees regardless of
the ANGDIR system variable setting (set in the Drawing Units dialog box). Angles
specified when creating new objects rely on the cursor location to determine the
positive angle direction.

Dynamic Prompts

When dynamic prompts (fig. 7.14) are on, prompts are displayed in a tooltip
near the cursor. You can enter a response in the tooltip instead of on the command
line. Press the DOWN ARROW key to view and select options. Press the UP
ARROW key to display recent input.

Note. To use PASTECLIP in a dynamic prompt tooltip, type a letter and then
backspace to delete it before you paste the entry. Otherwise, the entry is pasted into
the drawing as text.

Dynamic Input Tab (Drafting Settings Dialog Box) controls pointer input,
dimension input, dynamic prompting, and the appearance of drafting tooltips.

Enable Pointer Input

Turns on pointer input. When pointer input and dimensional input are both
turned on, dimensional input supersedes pointer input when it is available.
(DYNMODE system variable).

99



Pointer Input

Displays the location of the crosshairs as coordinate values in a tooltip near the
cursor. When a command prompts for a point, you can enter coordinate values in the
tooltip instead of on the command line.

Preview Area shows an example of pointer input.

Settings Displays the Pointer Input Settings dialog box.

Enable Dimension Input

Turns on dimensional input. Dimensional input is not available for some
commands that prompt for a second point. (DYNMODE system variable).

Dimension Input

Displays a dimension with tooltips for distance value and angle value when a
command prompts for a second point or a distance. The values in the dimension
tooltips change as you move the cursor. You can enter values in the tooltip instead of
on the command line.

Preview Area shows an example of dimensional input.

Settings displays the Dimension Input Settings dialog box.

Dynamic Prompts

Displays prompts in a tooltip near the cursor when necessary in order to
complete the command. You can enter values in the tooltip instead of on the
command line.

Preview Area shows an example of dynamic prompts.

Show Command Prompting and Command Input near the Crosshairs displays
prompts in Dynamic Input tooltips. (DYNPROMPT system variable).

Practical work

Purpose: acquiring skills of geometrical constructing with the use of
Object Snap

Work order

Create a new drawing - tsk2.dwg and save it in the personal folder.
Create a new layer.

Disable the snap mode.

Draw 10 circles of different diameters.

Join their centers with a closed polyline (none-zero width).
Create a new layer.

Disable the snap mode.

Draw 8 segments and 5 arcs of arbitrary sizes.

9. Join their centers with a closed polyline (none-zero width).

10. Join their extreme points with a closed polyline (none-zero width).
11. Create a new layer.

12. Disable the snap mode.

XA B =

100



13. Draw a circle, 5 segments, intersecting the circle fully, and 7 arcs,
intersecting the circle fully.

14. Join together the points of the circle and segments, the circle and arcs
intersections with a closed polyline (none-zero width).

15. Create a new layer.

16. Copy all the entities created in pp. 2—14.

17. Remove all these entities into the new layer (using the CHANGE
command).

18. Rotate all the entities (around the point located to the left of the drawing),
consistently, on 43, 178, 251, -36 degrees.

19. Create a new layer.

20. Copy all the entities created in pp. 2—14.

21. Transfer all these entities into a new layer (using the CHANGE command).

22. Change the sizes of all the entities (a base point is found approximately in
the center of the drawing), consistently, in 3.45, 0.79, 35.78/67.45 times.

23. Save the drawing in the personal folder and compress it (Zip).

24. Save this archive in the Academy distance learning system.

Basic theoretical information

Use Precision Tools

You can use a variety of precision drawing tools to help you produce accurate
drawings quickly and without performing tedious calculations.

You can use Drafting Settings Dialog Box that specifies drafting settings
organized for drawing aids in four categories: Snap and Grid, Polar Tracking, Object
Snap, and Dynamic Input.

Snap and Grid

To enhance drawing speed and efficiency, you can display and snap to a
rectangular grid. You can also control its spacing, angle, and alignment.

The grid is a rectangular pattern of dots or lines that extends over the area you
specify as the grid limits. Using the grid is similar to placing a sheet of grid paper
under a drawing. The grid helps you align objects and visualize the distances between
them. The grid is not plotted.

Snap mode restricts the movement of the crosshairs to intervals that you define.
When Snap mode is on, the cursor seems to adhere, or «snap,» to an invisible
rectangular grid. Snap is useful for specifying precise points with the arrow keys or
the pointing device.

Grid mode and Snap mode are independent but are often turned on at the same
time.

Polar Tracking

Polar tracking restricts cursor movement to specified angles. PolarSnap
restricts cursor movement to specified increments along a polar angle.

When you are creating or modifying objects, you can use polar tracking to
display temporary alignment paths defined by the polar angles you specify. In 3D
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views, polar tracking additionally provides an alignment path in the up and down
directions. In that case, the tooltip displays a +Z or -Z for the angle.

Polar angles are relative to the orientation of the current user coordinate system
(UCS) and the setting for the base angle convention in a drawing. The angle base
direction is set in the Drawing Units dialog box.

Use PolarSnap to snap to specified distances along the alignment path. For
example, in the following illustration you draw a two-unit line from point 1 to point
2, and then draw a two-unit line to point 3 at a 45-degree angle to the line. If you turn
on the 45-degree polar angle increment, an alignment path and tooltip are displayed
when your cursor crosses the 0 or 45-degree angle. The alignment path and tooltip
disappear when you move the cursor away from the angle.

As you move your cursor, alignment paths and tooltips are displayed when you
move the cursor near polar angles. The default angle measurement is 90 degrees. Use
the alignment path and tooltip to draw your object. You can use polar tracking with
Intersection and Apparent Intersection object snaps to find where a polar alignment
path intersects another object.

Note. Ortho mode and polar tracking cannot be on at the same time. Turning on
polar tracking turns off Ortho mode. Similarly, PolarSnap and grid snap cannot be on
at the same time. Turning on PolarSnap turns off grid snap.

Object Snap

Use object snaps to specify precise locations on objects. For example, you can
use an object snap to draw a line to the center of a circle or to the midpoint of a
polyline segment.

You can specify an object snap whenever you are prompted for a point. By
default, a marker and a tooltip are displayed when you move the cursor over an object
snap location on an object. This feature, called AutoSnap™, provides a visual clue
that indicates which object snaps are in effect.

To specify an object snap at a prompt for a point, you can:

e Press SHIFT and right-click to display the Object Snap shortcut menu;

e Click an object snap button on the Object Snap toolbar;

e Enter the name of an object snap at the command prompt.

When you specify an object snap at a prompt for a point, the object snap stays
in effect only for the next point that you specify.

Note. Object snaps work only when you are prompted for a point. If you try to
use an object snap at the Command prompt, an error message is displayed.

Object Snap Modes

Lists object snaps that you can turn on as running object snaps.

Endpoint snaps to the closest endpoint of an arc, elliptical arc, line, multiline,
polyline segment, spline, region, or ray, or to the closest corner of a trace, solid, or
3D face.

Midpoint snaps to the midpoint of an arc, ellipse, elliptical arc, line, multiline,
polyline segment, region, solid, spline, or xline.

Center snaps to the center of an arc, circle, ellipse, or elliptical arc.

Node snaps to a point object, dimension definition point, or dimension text
origin.
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Quadrant snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.

Intersection snaps to the intersection of an arc, circle, ellipse, elliptical arc,
line, multiline, polyline, ray, region, spline, or xline. Extended Intersection is not
available as a running object snap.

Intersection and Extended Intersection do not work with edges or corners of 3D
solids.

Note. You might get varying results if you have both the Intersection and
Apparent Intersection running object snaps turned on at the same time.

Extension causes a temporary extension line or arc to be displayed when you
pass the cursor over the endpoint of objects, so you can specify points on the
extension.

Note. When working in perspective view, you cannot track along the extension
line of an arc or elliptical arc.

Insertion snaps to the insertion point of an attribute, a block, a shape, or text.

Perpendicular snaps to a point perpendicular to an arc, circle, ellipse, elliptical
arc, line, multiline, polyline, ray, region, solid, spline, or xline. Deferred
Perpendicular snap mode is automatically turned on when the object you are drawing
requires that you complete more than one perpendicular snap. You can use a line, arc,
circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to
draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular
lines between such objects. When the aperture box passes over a Deferred
Perpendicular snap point, an AutoSnap tooltip and marker are displayed.

Tangent snaps to the tangent of an arc, circle, ellipse, elliptical arc, or spline.
Deferred Tangent snap mode is automatically turned on when the object you are
drawing requires that you complete more than one tangent snap. You can use
Deferred Tangent to draw a line or xline that is tangent to arcs, polyline arcs, or
circles. When the aperture box passes over a Deferred Tangent snap point, a marker
and an AutoSnap tooltip are displayed.

Note. When you use the From option in conjunction with the Tangent snap
mode to draw objects other than lines from arcs or circles, the first point drawn is
tangent to the arc or circle in relation to the last point selected in the drawing area.

Nearest snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line,
multiline, point, polyline, ray, spline, or xline.

Apparent Intersection snaps to the visual intersection of two objects that are
not in the same plane but may appear to intersect in the current view. Extended
Apparent Intersection is not available as a running object snap. Apparent and
Extended Apparent Intersection do not work with edges or corners of 3D solids.

Note. You might get varying results if you have both the Intersection and
Apparent Intersection running object snaps turned on at the same time.

Parallel constrains a line segment, polyline segment, ray or xline to be parallel
to another linear object. After you specify the first point of a linear object, specify the
parallel object snap. Unlike other object snap modes, you move the cursor and hover
over another linear object until the angle is acquired. Then, move the cursor back
toward the object that you are creating. When the path of the object is parallel to the
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previous linear object, an alignment path is displayed, which you can use to create the
parallel object.

Note. Turn off ORTHO mode before using the parallel object snap. Object snap
tracking and polar snap are turned off automatically during a parallel object snap
operation. You must specify the first point of a linear object before using the parallel
object snap.

Dynamic Input

Dynamic Input provides a command interface near the cursor to help you keep
your focus in the drafting area.

When Dynamic Input is on, tooltips display information near the cursor that is
dynamically updated as the cursor moves. When a command is active, the tooltips
provide a place for user entry.

After you type a value in an input field and press TAB, the field then displays a
lock icon, and the cursor is constrained by the value that you entered. You can then
enter a value for the second input field. Alternately, if you type a value and press
ENTER, the second input field is ignored and the value is interpreted as direct
distance entry.

The actions required to complete a command or to use grips are similar to those
for the command prompt. The difference is that your attention can stay near the
Cursor.

Dynamic Input is not designed to replace the command window. You can hide
the command window to add screen area for drawing, but you will need to display it
for some operations. Press F2 to hide and display command prompts and error
messages as needed. Alternately, you can undock the command window and use
Auto-hide to roll open or roll up the window.

Pointer Input

When pointer input is on and a command is active, the location of the
crosshairs is displayed as coordinates in a tooltip near the cursor. You can enter
coordinate values in the tooltip instead of on the command line.

The default for second and subsequent points is relative polar coordinates
(relative Cartesian for RECTANG). There is no need to type the at sign (@). If you
want to use absolute coordinates, use the pound sign (#) prefix. For example, to move
an object to the origin, for the second point prompt, enter #0,0.

Use the pointer input settings to change the default format for coordinates and
to control when pointer input tooltips are displayed.

Dimensional Input

When dimensional input is on, the tooltips display distance and angle values
when a command prompts for a second point. The values in the dimensional tooltips
change as you move the cursor. Press TAB to move to the value you want to change.
Dimensional input is available for ARC, CIRCLE, ELLIPSE, LINE, and PLINE.

Use the dimensional input settings to display only the information you want
to see.

When you use grips to stretch objects or when you create new objects,
dimensional input displays only acute angles, that is, all angles are displayed as 180
degrees or less. Thus, an angle of 270 degrees is displayed as 90 degrees regardless of
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the ANGDIR system variable setting (set in the Drawing Units dialog box). Angles
specified when creating new objects rely on the cursor location to determine the
positive angle direction.

Dynamic Prompts

When dynamic prompts are on, prompts are displayed in a tooltip near the
cursor. You can enter a response in the tooltip instead of on the command line. Press
the DOWN ARROW key to view and select options. Press the UP ARROW key to
display recent input.

Note. To use PASTECLIP in a dynamic prompt tooltip, type a letter and then
backspace to delete it before you paste the entry. Otherwise, the entry is pasted into
the drawing as text.

Self-examination questions

Actions on objects. Compliance with the accuracy of the constructions.
Change the properties of objects. Changing properties tools.
Snap and Grid.

The essence and purpose of the object snap.

Control the display style and area of the grid.

Constant object snap.

One-time object snap.

Object snap setting.

9. Endpoint object snap mode.

10. Midpoint object snap mode.

11. Center object snap mode.

12. Quadrant object snap mode.

13. Intersection object snap mode.

14. Extension object snap mode.

15. Insertion object snap mode.

16. Perpendicular object snap mode.

17. Tangent object snap mode.

18. Nearest object snap mode.

19. Parallel object snap mode.
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Chapter 8
Working with a text in the AutoCAD program

Overview of Creating Text

The text you add to your drawings conveys a variety of information. It may be
a complex specification, title block information, a label, or even part of the drawing.

Single-Line Text

For short entries that do not require multiple fonts or lines, create single-line
text. Single-line text is most convenient for labels.

Multiline Text

For long, complex entries create multiline, or paragraph text. Multiline text
consists of any number of text lines or paragraphs that fit within a width you specify;
it can extend vertically to an indefinite length.

Regardless of the number of lines, each set of paragraphs created in a single
editing session forms a single object, which you can move, rotate, erase, copy, mirror,
or scale.

There are more editing options for multiline text than there are for single-line
text. For example, you can apply underlining, fonts, color, and text height changes to
individual characters, words, or phrases within a paragraph.

Annotative Text

Use annotative text for notes and labels in your drawing. You create annotative
text by using an annotative text style, which sets the height of the text on the paper.

For more information about creating and working with an annotative text, see
Create Annotative Text.

Create Single-Line Text

You can use single-line text to create one or more lines of text, where each text
line is an independent object that you can relocate, reformat, or otherwise modify.

Use single-line text (TEXT) to create one or more lines of text, ending each
line when you press ENTER. Each text line is an independent object that you can
relocate, reformat, or otherwise modify.

When you create single-line text, you assign a text style and set alignment. The
text style sets the default characteristics of the text object. The alignment determines
what part of the text character aligns with the insertion point. Use the TEXT
command to enter the text in-place, or enter -text on the command line to enter the
text on the command line.

You can insert a field in single-line text. A field is text that is set up to display
data that might change. When the field is updated, the latest value of the field is
displayed.
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The text styles used for single-line text are the same as those used for multiline
text. When you create text, you assign an existing style by entering its name at the
Style prompt. If you need to apply formatting to individual words and characters, use
multiline text instead of single-line text.

You can also compress single-line text to fit between points that you specify.
This option stretches or squeezes the text to fill the designated space.

The DTEXTED system variable specifies the user interface displayed for
editing single-line text.

Align Single-Line Text
As you create text, you can align it. That is, you can justify it with one of the
alignment options shown in the following illustrations. Left alignment is the default.

To left-align text, do not enter an option at the Justify prompt.
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Figure 8.1 — Single-Line Text
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The TEXT command creates a single-line text object.

Menu: Draw» Text» Single Line Text

Command entry: text

It displays a simplified version of the In-Place Text Editor that consists of a
bounding box that is the height of the text and expands as you type. Right-click to
select options on the shortcut menu (fig. 8.1).

If TEXT was the last command entered, pressing ENTER at the Specify Start
Point of Text prompt skips the prompts for paper height and rotation angle. The text
that you enter in the In-Place Text Editor for single-line text is placed directly
beneath the previous line of text. The point that you specified at the prompt is also
stored as the insertion point of the text.

If the DTEXTED system variable is set to 1, text created using TEXT or
DTEXT displays the Edit Text dialog box.

If DTEXTED is set to 2, the In-Place Text Editor is displayed. When creating
text, you can click anywhere in a drawing to create a new text block. You can also
use the keyboard to move among text blocks (for example: for new text created using
the TEXT command, you can navigate through text groups by pressing TAB or
Shift+TAB, or edit a group of text lines by pressing ALT and clicking each text
object).

Note. Text that would otherwise be difficult to read (if it is very small, very
large, or is rotated) is displayed at a legible size and is oriented horizontally so that
you can easily read and edit it.

You can enter special characters and format text by entering Unicode strings
and control codes.

Use -TEXT to honor the TEXTEV AL system variable.

DTEXT is the same as TEXT.

Create Multiline Text

You can create one or more paragraphs of multiline text (mtext) in the In-Place
Text Editor (or an alternative text editor) or use prompts on the command line. You
can also insert text from a file saved in ASCII or RTF format.

Before entering or importing text, you specify opposite corners of a text
bounding box that defines the width of the paragraphs in the multiline text object.
The length of the multiline text object depends on the amount of text, not the length
of the bounding box. You can use grips to move or rotate a multiline text object.

The In-Place Text Editor displays the bounding box with a ruler at the top and
the Text Formatting toolbar. The editor is transparent so that, as you create text, you
can see whether the text overlaps other objects. To turn off transparency while you
work, select Opaque Background on the Options menu. You can also make the
background of the finished multiline text object opaque and set its color.

You can also insert fields in multiline text. A field is text that is set up to
display data that might change. When the field is updated, the latest value of the field
is displayed.
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Text Style

Most characteristics of the text are controlled by the text style, which sets the
default font and other options, such as line spacing, justification, and color. You can
use the current text style or select a new one. The STANDARD text style is the
default.

Within the multiline text object, you can override the current text style by
applying formatting such as underlining, boldface, and different fonts to individual
characters. You can also create stacked text, such as fractions or geometric tolerances
and insert special characters, including Unicode characters, for TrueType fonts.

Note. Not all SHX and TrueType text fonts support Unicode characters.

Text Properties

In the Properties palette, you can view and change the object properties of a
multiline text object, including properties that apply specifically to text:

e Justification determines where text is inserted with respect to the bounding
box and sets the direction of text flow as text is entered;

e Line space options control the amount of space between lines of text;

e Width defines the width of the bounding box and therefore controls where
the text wraps to a new line;

e Background inserts an opaque background so that objects under the text are
masked.

Justify Multiline Text

Justification of multiline text objects controls both text alignment and text flow
relative to the text insertion point.

There are nine justification settings for multiline text.

Justification controls both text alignment and text flow relative to the text
insertion point. Text is left-justified and right-justified with respect to the boundary
rectangle that defines the text width. Text flows from the insertion point, which can
be at the middle, the top, or the bottom of the resulting text object.

If a single word is longer than the width of the paragraph, the word will extend
beyond the paragraph boundary.

In-Place Text Editor
The MTEXT command creates paragraphs of text as a single multiline text
(mtext) object
Toolbar: Draw A

Menu: Draws Text» Multiline Text
Pointing device: Double-click a multiline text object.
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Command entry: mtext

Dashboard: Text panel, Multiline Text

After you specify the point for the opposite corner, the in-place text editor is
displayed.

If you specify one of the other options, or if you enter -mtext at the command
prompt, MTEXT bypasses the In-Place Text editor and displays additional command
prompts.

In-Place Text Editor Creates or modifies single or multiline text objects. You
can import or paste text from other files to use in multiline text, set tabs, adjust
paragraph and line spacing and alignment, and create and modify columns.

The In-Place Text Editor (fig. 8.2) includes a Text Formatting Toolbar, a
Paragraph Dialog Box, a Columns Menu, and an Display Options Menu. When a
table cell is selected for editing, the In-Place Text Editor displays column letters and
row numbers.

Displays Column menu Displays menu options

Displays MText Justification menu Displays ruler

Text Forrpatting
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Figure 8.2 — In-Place Text Editor
Text Formatting Toolbar

Controls the text style for a multiline text object and character and paragraph
formatting for selected text.

Note. Text that you paste from other word processing applications such as
Microsoft Word will retain most of its formatting. With the options in Paste Special,
you can strip out paragraph formatting such as paragraph-based alignment or
character formatting from the pasted text.
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Display Options Menu

Changes the behavior of the Text Formatting toolbar and provides additional
editing options. Options are specific to the Display Options menu and are not
available on the Text Formatting toolbar.

Note. Some options may not be available depending on what you are editing.

Show Toolbar

Controls display of the Text Formatting toolbar. To restore display of the
toolbar, right-click in the editor and click Option » Show Toolbar.

Show Options

Expands the Text Formatting toolbar to show more options.

Show Rulers

Controls the display of the ruler.

Opaque Background

When selected, makes the background of the editor opaque. By default, the
editor is transparent. (Not available for table cells).

Text Highlight Color

Displays the AutoCAD generic Select Color dialog box. Specifies the highlight
color when text is selected.

Practical work

Purpose: acquiring skills of a text input and editing
Work order

1. Open the drawing tsk2.dwg.

2. Create a new layer.

3. Using the TEXT command, write a short autobiography (you must use the
command TEXT options Start point, Align, Fit, Center, Mid point).

4. Create a new layer.

5. Copy the text created in p. 3 into a free place.

6. Transfer the text into the new layer (using the CHANGE command).

7. Mirror the text (using the MIRROR command) in relation to a line lying to
the left of the text (allow AutoCAD to change the text orientation).

8. Mirror the source text in relation to a line lying to the right of text (do not
allow AutoCAD to change the text orientation).

9. Mirror the text (the MIRROR command) in relation to a line lying below the
text (allow AutoCAD to change the text orientation).

10. Mirror the source text in relation to a line lying above the text (deny
AutoCAD changing the text orientation).

11. Create a new layer.

12. Draw a none-zero width closed polyline consisting of 5 straight lines and 5
arc segments.
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13. Use the BREAK command in each of the segments to «place windowsy,
that is, to delete a part of every segment.

14. Save the drawing in the personal folder and compress it (Zip).

15. Save this archive in the Academy distance learning system.

Basic theoretical information

Creating Text

The text you add to your drawings conveys a variety of information. It may be
a complex specification, title block information, a label, or even part of the drawing.

For short entries that do not require multiple fonts or lines, create single-line
text. Single-line text is most convenient for labels.

For long, complex entries, create multiline, or paragraph text. Multiline text
consists of any number of text lines or paragraphs that fit within a width you specify;
it can extend vertically to an indefinite length.

Regardless of the number of lines, each set of paragraphs created in a single
editing session forms a single object, which you can move, rotate, erase, copy, mirror,
or scale.

There are more editing options for multiline text than there are for single-line
text. For example, you can apply underlining, fonts, color, and text height changes to
individual characters, words, or phrases within a paragraph.

Use annotative text for notes and labels in your drawing. You create annotative
text by using an annotative text style, which sets the height of the text on the paper.

For more information about creating and working with an annotative text, see
Create Annotative Text.

Create Single-Line Text

You can use single-line text to create one or more lines of text, where each text
line is an independent object that you can relocate, reformat, or otherwise modify.

Use single-line text (TEXT) to create one or more lines of text, ending each
line when you press ENTER. Each text line is an independent object that you can
relocate, reformat, or otherwise modify.

When you create single-line text, you assign a text style and set alignment. The
text style sets the default characteristics of the text object. The alignment determines
what part of the text character aligns with the insertion point. Use the TEXT
command to enter the text in-place, or enter -text on the command line to enter the
text on the command line.

You can insert a field in single-line text. A field is text that is set up to display
data that might change. When the field is updated, the latest value of the field is
displayed.

The text styles used for single-line text are the same as those used for multiline
text. When you create text, you assign an existing style by entering its name at the
Style prompt. If you need to apply formatting to individual words and characters, use
multiline text instead of single-line text.
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You can also compress single-line text to fit between points that you specify.
This option stretches or squeezes the text to fill the designated space.

The DTEXTED system variable specifies the user interface displayed for
editing single-line text.

Create Multiline Text

You can create one or more paragraphs of multiline text (mtext) in the In-Place
Text Editor (or an alternative text editor) or use prompts on the command line. You
can also insert text from a file saved in ASCII or RTF format.

Before entering or importing text, you specify opposite corners of a text
bounding box that defines the width of the paragraphs in the multiline text object.
The length of the multiline text object depends on the amount of text, not the length
of the bounding box. You can use grips to move or rotate a multiline text object.

The In-Place Text Editor displays the bounding box with a ruler at the top and
the Text Formatting toolbar. The editor is transparent so that, as you create text, you
can see whether the text overlaps other objects. To turn off transparency while you
work, select Opaque Background on the Options menu. You can also make the
background of the finished multiline text object opaque and set its color.

You can also insert fields in multiline text. A field is text that is set up to
display data that might change. When the field is updated, the latest value of the field
is displayed.

Text Style

Most characteristics of the text are controlled by the text style, which sets the
default font and other options, such as line spacing, justification, and color. You can
use the current text style or select a new one. The STANDARD text style is the
default.

Within the multiline text object, you can override the current text style by
applying formatting such as underlining, boldface, and different fonts to individual
characters. You can also create stacked text, such as fractions or geometric tolerances
and insert special characters, including Unicode characters, for TrueType fonts.

Note. Not all SHX and TrueType text fonts support Unicode characters.

Text Properties

In the Properties palette, you can view and change the object properties of a
multiline text object, including properties that apply specifically to text:

¢ Justification determines where text is inserted with respect to the bounding
box and sets the direction of text flow as text is entered;

e Line space options control the amount of space between lines of text;

e Width defines the width of the bounding box and therefore controls where
the text wraps to a new line;

e Background inserts an opaque background so that objects under the text are
masked.

In-Place Text Editor

The MTEXT command creates paragraphs of text as a single multiline text
(mtext) object.

After you specify the point for the opposite corner, the in-place text editor is
displayed.
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If you specify one of the other options, or if you enter -mtext at the command
prompt, MTEXT bypasses the In-Place Text editor and displays additional command
prompts.

In-Place Text Editor Creates or modifies single or multiline text objects. You
can import or paste text from other files to use in multiline text, set tabs, adjust
paragraph and line spacing and alignment, and create and modify columns.

The In-Place Text Editor includes a Text Formatting Toolbar, a Paragraph
Dialog Box, a Columns Menu, and an Display Options Menu. When a table cell is
selected for editing, the In-Place Text Editor displays column letters and row
numbers.

Self-examination questions

MTEXT command.
List of MTEXT command prompts.
Corners prompt.
What is the Height prompt?
What is the Specify height prompt?
What is the Specify paper text height prompt?
The TL justify option.
The TC justify option.
The TR justify option.
. The ML justify option.
. The MC justify option.
. The MR justify option.
. The BL justify option.
. The BC justify option.
. The BR justify option.
. Describe the At least option.
. Describe the Distance option.
. Describe the Exactly option.
. Describe the Spacing factor option.
. Describe the Sets the line spacing to a multiple of single-line spacing
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option.
21. Describe the Rotation option.
22. Describe the Style option.
23. Describe the Style name option.
24. Describe the Width option.
25. Describe the Columns option.
26. Describe the Static option.
27. Describe the Dynamic option.
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Chapter 9
Building floor plans and facades
computer-aided design

Create Single-View Drawings (Model Space)

If you are going to create a two dimensional drawing that has one view, you
can create the drawing and its annotation entirely in model space. This is the
traditional method for creating drawings with AutoCAD.

Model Space Drafting

The process of creating and plotting a drawing file in model space is very
different from the process used in manual drafting.

In AutoCAD, there are two distinct working environments that are represented
by the Model and layout tabs. These tabs are located near the bottom of the drawing
area.

If you are going to create a two-dimensional drawing that has one view, you
can create both the model and its annotation entirely in model space, not using a
layout tab. This is the traditional method for creating drawings with AutoCAD. This
method is simple but has several limitations, including:

e [tis suitable for 2D drawings only

e [t does not support multiple views and view-dependent layer settings

e Scaling the annotation and title block requires computation unless you use
annotative objects.

With this method, you always draw geometric objects at full scale (1:1) and
text, dimensions, and other annotation at a scale that will appear at the correct size
when the drawing is plotted.

Draw, Scale, and Annotate in Model Space

If you draw and plot from model space, you must determine and apply a scale
factor to annotate objects before you plot.

You can draw and plot entirely from model space. This method is useful
primarily for two-dimensional drawings that have a single view. With this method,
you use the following process:

e Determine the unit of measurement (drawing units) for the drawing;

Specify the display style for the drawing unit;

Calculate and set the scale for dimensions, annotations, and blocks;
Draw at full scale (1:1) in model space;

Create the annotation and insert the blocks in model space;

Plot the drawing at the predetermined scale.
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You can also use annotative objects if you want to scale annotations
automatically. For information about using annotative objects and scaling annotations
automatically, see Scale Annotations.

Determine the Unit of Measurement

Before you begin drawing in model space, you determine the unit of
measurement (drawing units) that you plan to use. You decide what each unit on the
screen represents, such as an inch, a millimeter, a kilometer, or some other unit of
measurement. For example, if you are drawing a motor part, you might decide that
one drawing unit equals a millimeter. If you are drawing a map, you might decide
that one unit equals a kilometer.

For architectural projects you might decide that one unit equals a meter.

Specify the Display Style of Drawing Units

Once you have determined a drawing unit for the drawing, you need to specify
the style for displaying the drawing unit, which includes the unit type and precision.
For example, a value of 14.5 can be displayed as 14.500, 14-1/2, or 1°2-1/2».

Specify the display style of drawing units with the UNITS command. The
default drawing unit type is decimal.

Set the Scale for Annotations and Blocks

Before you draw, you should set the scale for dimensions, annotations, and
blocks in your drawings. Scaling these elements beforehand ensures that they are at
the correct size when you plot the final drawing.

You should enter the scale for the following objects:

Text. Set the text height as you create text or by setting a fixed text height in
the text style (STYLE).

Dimensions. Set the dimension scale in a dimension style (DIMSTYLE) or
with the DIMSCALE system variable.

Linetypes. Set the scale for noncontinuous linetypes with the CELTSCALE and
LTSCALE system variables.

Hatch patterns. Set the scale for hatch patterns in the Hatch and Gradient
dialog box (HATCH) or with the HPSCALE system variable.

Blocks. Specify the insertion scale for blocks either as you insert them, or set
an insertion scale in the Insert dialog box (INSERT) or in DesignCenter
(ADCENTER). The system variables used for inserting blocks are INSUNITS,
INSUNITSDEFSOURCE, and INSUNITSDEFTARGET. This also applies to the
border and title block of the drawing.

You can also use annotative objects if you want to scale annotations
automatically. For information about using annotative objects and scaling annotations
automatically, see Scale Annotations.

Determine the Scale Factor for Plotting

To plot your drawing from the Model tab, you calculate the exact scale factor
by converting the drawing scale to a ratio of 1:n. This ratio compares plotted units to
drawing units that represent the actual size of the objects you are drawing.
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For example, if you plan to plot at a scale of 1/4 inch = 1 foot, you would
calculate the scale factor 48 as follows:

1/4» = 12»

1=12x4

1 (plotted unit) = 48 (drawing units)

Using the same calculation, the scale factor for 1 centimeter = 1 meter is 100,
and the scale factor for 1 inch = 20 feet is 240.

Create Multiple-View Drawing Layouts (Paper Space)

Paper space is a sheet layout environment where you can specify the size of
your sheet, add a title block, display multiple views of your model, and create
dimensions and notes for your drawing.

Understand the Layout Process

There are two distinct working environments, or «spaces», in which you can
create objects in a drawing. These are represented by the Model and layout tabs.

Typically, a model composed of geometric objects is created in a three-
dimensional space called model space. A final layout of specific views and
annotations of this model is created in a two-dimensional space called paper space.
These spaces are accessible on two or more tabs near the bottom of the drawing area:
the Model tab and one or more layout tabs (fig. 9.1).

Note. These tabs can be hidden, appearing instead as buttons on the status bar
at the bottom-center of the application window.

Working on the Model tab, you draw a model of your subject at 1:1 scale.
Working on a layout tab, you can create one or more layout viewports, dimensions,
notes, and a title block to represent a drawing sheet.

i

i

' Model § Lapout f

MODEL

Figure 9.1 — Model space

Each layout viewport is like a picture frame containing a «photograph» of the
model in model space. Each layout viewport contains a view that displays the model
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at the scale and orientation that you specify. You can also specify which layers are
visible in each layout viewport.

After you finish arranging the layout, you turn off the layer that contains the
layout viewport objects. The views are still visible, and you can plot the layout
without displaying the viewport boundaries.

When you use a layout tab to prepare your drawing for plotting, you follow a
series of steps in a process.

You design the subject of your drawing on the Model tab (in model space) and
prepare it for plotting on a layout tab (in paper space).

There is one Model tab and one or more layout tabs at the bottom of the
drawing window.

Note. These tabs can be hidden, appearing instead as buttons on the status bar
at the bottom-center of the application window.

Process Summary
When you prepare a layout, you typically step through the following process:

e Create a model of your subject on the Model tab;

e Click a layout tab;

e Specify layout page settings such as plotting device, paper size, plot area,
plot scale, and drawing orientation;

e Insert a title block into the layout (unless you have started with a drawing
template that already has a title block);

e Create a new layer to be used for layout viewports;

e Create layout viewports and position them on the layout;

e Set the orientation, scale, and layer visibility of the view in each layout
viewport;

¢ Add dimensions and annotate in the layout as needed;

e Turn off the layer containing the layout viewports;

e Plot your layout.

You can also use annotative objects if you want to annotate your drawing in
model space and scale the annotations automatically. For information about using
annotative objects and scaling annotations automatically, see Scale Annotations.

Work with Model Space and Paper Space

There are several benefits to switching between model space and paper space
to perform certain tasks. Use model space for creating and editing your model. Use
paper space for composing your drawing sheet and defining views.

Work on the Model Tab

The Model tab accesses a limitless drawing area called model space. In model
space, you draw, view, and edit your model.

In model space, you draw your model at 1:1 scale, and you decide whether one
unit represents one millimeter, one centimeter, one inch, one foot, or whatever unit is
most convenient or customary in your business.
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On the Model tab, you can view and edit model space objects. The crosshairs
cursor is active over the entire drawing area.

Work on a Layout Tab

Layout tabs access an area called paper space. In paper space, you place your
title block, create layout viewports to display views, dimension your drawing, and
add notes (fig. 9.2).

In paper space, one unit represents the paper distance on a plotted sheet. The
units will be in either millimeters or inches, depending on the plot setup for your
plotter.

On a layout tab, you can view and edit paper space objects, such as layout
viewports and title blocks. You can also move an object (such as a leader or a title
block) from model space to paper space (or vice versa). The crosshairs cursor is
active over the entire layout area.

Y Model ) Layoutl §

FAPER

Figure 9.2 — Layout space

Note. These tabs can be hidden, appearing instead as buttons on the status bar
at the bottom-center of the application window. To display the tabs, right-click the
Model or layout button and click Display Layout and Model Tabs on the shortcut
menu.

Access Model Space from a Layout Viewport

You can access model space from a layout viewport to edit objects, to freeze
and thaw layers, and to adjust the view.

After creating viewport objects, you can access model space from a layout
viewport to perform the following tasks:

e Create and modify objects in model space inside the layout viewport;

e Pan the view inside the layout viewport and change layer visibility.
The method you use to access model space depends on what you plan to do.
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Create and Modify Objects in a Layout Viewport

If you plan to create or modify objects, use the button on the status bar to
maximize the layout viewport. The maximized layout viewport expands to fill the
drawing area. The center point and the layer visibility settings of the viewport are
retained, and the surrounding objects are displayed.

You can pan and zoom while you are working in model space, but when you
restore the viewport to return to paper space, the position and scale of the objects in
the layout viewport are restored.

Note. If you use PLOT while a viewport is maximized, the layout tab is
restored before the Plot dialog box is displayed. If you save and close the drawing
while a viewport is maximized, the drawing opens with the layout tab restored.

If you choose to switch to the Model tab to make changes, the layer visibility
settings are the settings for the drawing as a whole, not the settings for that particular
layout viewport. Also, the view is not centered or magnified the same way it is in the
layout viewport.

Adjust the View in a Layout Viewport

If you plan to pan the view and change the visibility of layers, double-click
within a layout viewport to access model space. The viewport border becomes
thicker, and the crosshairs cursor is visible in the current viewport only. All active
viewports in the layout remain visible while you work. You can freeze and thaw
layers in the current viewport in the Layer Properties Manager, and you can pan the
view. To return to paper space, double-click an empty area on the layout outside a
viewport. The changes you made are displayed in the viewport.

If you set the scale in the layout viewport before you access model space, you
can lock the scale to prevent changes. When the scale is locked, you cannot use
Z0OOM while you work in model space.

Create and Modify Layout Viewports

You can create a single layout viewport (fig. 9.3) that fits the entire layout or
create multiple layout viewports in the layout. Once you create the viewports, you
can change their size, their properties, and also scale and move them as needed.

Note. It is important to create layout viewports on their own layer. When you
are ready to plot, you can turn off the layer and plot the layout without plotting the
boundaries of the layout viewports.

With MVIEW, you have several options for creating one or more layout
viewports. You can also use COPY and ARRAY to create multiple layout viewports.
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Figure 9.3 — Layout viewport

Create Nonrectangular Layout Viewports

You can create a new viewport with nonrectangular boundaries by converting
an object drawn in paper space into a layout viewport.

The MVIEW command provides two options to assist you in defining an
irregularly shaped viewport.

With the Object option, you can select a closed object, such as a circle or
closed polyline created in paper space, to convert into a layout viewport. The object
that defines the viewport boundary is associated with the viewport after the viewport
is created.

The Polygonal option can be used to create a nonrectangular layout viewport
by specifying points. The prompt sequence is the same as the prompt sequence for
creating a polyline.

Note. When you want to suppress the display of the boundary of a layout
viewport, you should turn off the layer of the nonrectangular viewport instead of
freezing it. If the layer of a nonrectangular layout viewport is frozen, the boundary is
not displayed, but the viewport is not clipped.

Resize Layout Viewports
If you want to change the shape or size of a layout viewport, you can use grips
to edit the vertices just as you edit any object with grips.

Clip Layout Viewports

You can redefine the boundary of a layout viewport by using the VPCLIP
command. To clip a layout viewport, you can use your pointing device to either select
an existing object to designate as the new boundary, or specify the points of a new
boundary.
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Control Views in Layout Viewports

When you create a layout, you can add layout viewports that act as windows
into model space. In each layout viewport, you can control the view that is displayed.

Scale Views in Layout Viewports

To scale each displayed view in the plotted drawing accurately, set the scale of
each view relative to paper space.

You can change the view scale of the viewport using:

e The Properties palette,

e The XP option of the ZOOM command,

e The Viewports toolbar.

Note. You can modify the list of scales that are displayed in all view and plot
scale lists with SCALELISTEDIT.

When you work in a layout, the scale factor of a view in a layout viewport
represents a ratio between the actual size of the model displayed in the viewport and
the size of the layout. The ratio is determined by dividing the paper space units by the
model space units. For example, for a quarter-scale drawing, the ratio would be a
scale factor of one paper space unit to four model space units, or 1:4.

Scaling or stretching the layout viewport border does not change the scale of
the view within the viewport.

Lock the Scale of Layout Viewports

Once you set the viewport scale, you cannot zoom within a viewport without
changing the viewport scale. By locking the viewport scale first, you can zoom in to
view different levels of detail in your viewport without altering the viewport scale.

Scale locking locks the scale that you set for the selected viewport. Once the
scale is locked, you can continue to modify the geometry in the viewport without
affecting the viewport scale. If you turn a viewport’s scale locking on, most of the
viewing commands, such as VPOINT, DVIEW, 3DORBIT, PLAN, and VIEW, no
longer function in that viewport.

Note. Viewport scale locking is also available for nonrectangular viewports. To
lock a nonrectangular viewport, you must perform an extra step in the Properties
palette to select the viewport object rather than the viewport clipping boundary.

Control Visibility in Layout Viewports
You can control the visibility of objects in layout viewports using several

methods. These methods are useful for emphasizing or hiding different elements of a
drawing, and for reducing screen regeneration time.
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Freeze Specified Layers in a Layout Viewport

A major benefit to using layout viewports is that you can selectively freeze
layers in each layout viewport (fig. 9.4). You can also specify default visibility
settings for new viewports and for new layers. As a result, you can view different
objects in each layout viewport.

You can freeze or thaw layers in current and future layout viewports without
affecting other viewports. Frozen layers are invisible. They are not regenerated or
plotted. In the illustration, the layer showing terrain has been frozen in one viewport.

Figure 9.4 — Freeze Specified Layers in a Layout Viewport

Thawing the layer restores visibility. The easiest way to freeze or thaw layers
in the current viewport is to use the Layer Properties Manager.

In the Layer Properties Manager, on the right side, use the column labeled VP
Freeze to freeze one or more layers in the current layout viewport. To display the VP
Freeze column, you must be on a layout tab. Specify the current layout viewport by
double-clicking anywhere within its borders.

Freeze or Thaw Layers Automatically in New Layout Viewports

You can set visibility defaults for specific layers in all new layout viewports.
For example, you can restrict the display of dimensions by freezing the
DIMENSIONS layer in all new viewports. If you create a viewport that requires
dimensions, you can override the default setting by changing the setting in the current
viewport. Changing the default for new viewports does not affect existing viewports.

Create New Layers That Are Frozen in All Layout Viewports

You can create new layers that are frozen in all existing and new layout
viewports. Then you can thaw the layers in the viewports you specify. This is a
shortcut for creating a new layer that is visible only in a single viewport.
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Screen Objects in Layout Viewports

Screening refers to applying less ink to an object when it is plotted. The object
appears dimmer on the screen and on the plotted paper. Screening can be used to help
differentiate objects in a drawing without changing the objects’ color properties.

To assign a screening value to an object, you must assign a plot style to the
object, and then define the screening value in that plot style.

You can assign a screening value from 0 to 100. The default setting, 100,
means no screening is applied, and the object is displayed with normal ink intensity.
A screening value of 0 means the object contains no ink and is thus invisible in that
viewport.

Turn Layout Viewports On or Off

You can save time by turning some layout viewports off or by limiting the
number of active viewports (fig. 9.5).

Displaying a large number of active layout viewports can affect your system’s
performance as the content of each layout viewport regenerates. You can save time
by turning some layout viewports off or by limiting the number of active viewports.
The following illustration shows the effects of turning off two layout viewports.

New layout viewports are turned on by default. If you turn off the layout
viewports you aren’t using, you can copy layout viewports without waiting for each
one to regenerate.
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Figure 9.5 — Turn Layout Viewports On or Off

If you don’t want to plot a layout viewport, you can turn the layout viewport
off.

Scale Linetypes in Layout Viewports

You can scale linetypes (fig. 9.6) in paper space either based on the drawing
units of the space in which the object was created or based on the paper space units.
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You can set the PSLTSCALE system variable to maintain the same linetype
scaling for objects displayed at different zoom factors in a layout and in a layout
viewport. For example, with PSLTSCALE set to 1 (default), set the current linetype
to dashed, and then draw a line in a paper space layout. In the layout, create a
viewport with a zoom factor of 1x, make that layout viewport current, and then draw
a line using the same dashed linetype. The dashed lines should appear to be the same.
If you change the viewport zoom factor to 2x, the linetype scaling for the dashed line
in the layout and the dashed line in the layout viewport will be the same, regardless of
the difference in the zoom factor.

PELTSCALE=1, dashes scaled fo PELTSCALE=0, dashes scaled to space
paper space where they were created

Figure 9.6 — Scale Linetypes in Layout Viewports

With PSLTSCALE turned on, you can still control the dash lengths with
LTSCALE and CELTSCALE. In the following illustration, the pattern of the
linetypes in the drawing on the left has been scaled to be the same regardless of the
scale of the view. In the drawing on the right, the scale of the linetypes matches the
scale of each view.

Align Views in Layout Viewports

You can arrange the elements of your drawing by aligning the view in one
layout viewport with the view in another viewport.

For angled, horizontal, and vertical alignments, you can move each layout
viewport relative to distances defined by the model-space geometry displayed.

To adjust the views on a layout with precision, you can create construction
geometry, use object snaps on the model-space objects displayed in layout viewports,
or use one of the cursor constraint features available on the status bar.

Rotate Views in Layout Viewports

You can rotate an entire view within a layout viewport by changing the UCS
and using the PLAN command (fig. 9.7).
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With the UCS command, you can rotate the XY plane at any angle around the
Z axis. When you enter the PLAN command, the view rotates to match the
orientation of the XY plane.

For a faster method, use the Align and then Rotate View options in the
MVSETUP command.

Note. The ROTATE command rotates individual objects only and should not
be used to try to rotate a view.
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Figure 9.7 — Align Views in Layout Viewports

Work with Sheets in a Sheet Set

With the Sheet Set Manager, you can organize drawing layouts into named
sheet sets (fig. 9.8). The sheets in a sheet set can be transmitted, published, and

archived as a unit.
A sheet set is an organized collection of sheets from several drawing files. A
sheet is a selected layout from a drawing file.
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Sets of drawings are the primary deliverable for most design groups. Sets of
drawings communicate the overall design intent of a project and provide the
documentation and specifications for the project. However, managing sets of
drawings manually can be complicated and time consuming.

With the Sheet Set Manager, you can manage drawings as sheet sets. A sheet
set is an organized and named collection of sheets from several drawing files. A sheet
is a selected layout from a drawing file. You can import a layout from any drawing
into a sheet set as a numbered sheet.
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You can manage, transmit, publish, and archive sheet sets as a unit.
Using the controls in the Sheet Set Manager, you can create, organize, and
manage sheets in a sheet set.

Practical work

Purpose: to learn how to use AutoCAD for a real architectural project
automated implementation

To develop skills of entities creating and editing, working with layers,
geometrical constructing, using drawing and displaying procedures, text information
input and editing. To acquire skills of design drawing constructing for the projects
executed in the AutoCAD program. To learn how to plot the drawings on paper.
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This laboratory work is basic for the process of two-dimensional graphics
studying.

It is necessary to build plans of a cottage (not less than two floors). Apartments
plans and specifications development for two floors will be described later on.
However it is very useful to add something to the project (for example, a basement).

Work order:

1. Preliminary work (without a computer).

1.1 Think the project over and draw sketches.

1.2 Define approximately which information will be plotted on A4
format paper. Minimum set of leaves (for a two-storied cottage): the ground and the
Ist floor plans and apartment specifications.

1.3 Taking into account the objects sizes, define the scale to be used on
the A4 format paper. You must enter all the objects sizes in natural scale units (1 unit
of drawing equals to 1 meter). However to define basic data of project is necessary
just at this stage.

2. Create a new drawing.

3. Create a new layer to draw a boundary and a stamp for the A4 format.
Enter the boundary and stamp sizes in natural scale units (1 unit of drawing equals to
1 millimeter).

4. Draw the plan of the ground floor.

4.1 In a new layer, draw a sketch of the ground floor using thin lines.
Windows and doors are not to be indicated at this stage. Enter the objects sizes in
natural scale plan units (1 unit of the drawing is equal to 1 millimeter).

4.2 Create doorways and window openings.

4.3 In anew layer, outline the walls with wide polylines.

4.4 In a new layer insert windows and doors.

4.5 In anew layer insert the numbers of apartments.

5. Draw the ground floor apartments specification.

5.1 Create a new layer.

5.2 Copy and paste the boundary and the stamp in this layer.

5.3 In the boundary, create a list of the apartments. All the sizes related
to the text enter in millimeters.

6. Copy and paste the information for the 1st floor in new layers. Edit the
information.

6.1 Create necessary new layers.

6.2 Copy and paste the information for the ground floor in new layers.

6.3 Edit the information and get a plan and apartments specification for the
Ist floor.

7. Place the floors plans within the boundaries.

7.1 Create a new layer.

7.2 Copy and paste the boundary and the stamp on this layer.

7.3 Match the boundary and plan sizes of the ground floor. Do not
change the plan, but change the sizes of the boundary in accordance with the scale
chosen.
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7.4 Transfer the plan to a proper place within the boundary.
7.5 Repeat actions of pp. 7.1-7.4 for the 1st floor.
8. Print out the information, using Window output region determination
option and Fit output scale determination option.
9. Save the drawing in the personal folder and compress it (Zip).
10. Save this archive in the Academy distance learning system.

Basic theoretical information

Create Single-View Drawings (Model Space)

If you are going to create a two dimensional drawing that has one view, you
can create the drawing and its annotation entirely in model space. This is the
traditional method for creating drawings with AutoCAD.

Model Space Drafting

The process of creating and plotting a drawing file in model space is very
different from the process used in manual drafting.

In AutoCAD, there are two distinct working environments that are represented
by the Model and layout tabs. These tabs are located near the bottom of the drawing
area.

If you are going to create a two-dimensional drawing that has one view, you
can create both the model and its annotation entirely in model space, not using a
layout tab. This is the traditional method for creating drawings with AutoCAD. This
method is simple but has several limitations, including:

e [t is suitable for 2D drawings only.

e [t does not support multiple views and view-dependent layer settings.

e Scaling the annotation and title block requires computation unless you use
annotative objects.

With this method, you always draw geometric objects at full scale (1:1) and
text, dimensions, and other annotation at a scale.

Draw, Scale, and Annotate in Model Space

If you draw and plot from model space, you must determine and apply a scale
factor to annotate objects before you plot.

You can draw and plot entirely from model space. This method is useful
primarily for two-dimensional drawings that have a single view.

Create Multiple-View Drawing Layouts (Paper Space)

Paper space is a sheet layout environment where you can specify the size of
your sheet, add a title block, display multiple views of your model, and create
dimensions and notes for your drawing.

There are two distinct working environments, or «spaces», in which you can
create objects in a drawing. These are represented by the Model and layout tabs.

Typically, a model composed of geometric objects is created in a three-
dimensional space called model space. A final layout of specific views and
annotations of this model is created in a two-dimensional space called paper space.
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These spaces are accessible on two or more tabs near the bottom of the drawing area:
the Model tab and one or more layout tabs.

Note. These tabs can be hidden, appearing instead as buttons on the status bar
at the bottom-center of the application window.

Working on the Model tab, you draw a model of your subject at 1:1 scale.
Working on a layout tab, you can create one or more layout viewports, dimensions,
notes, and a title block to represent a drawing sheet.

Self-examination questions

Model Space and Paper Space.
Exporting a Layout to Model Space in a New Drawing.
Aligning Views on a Layout.
Named Page Setups.
Model Space Viewports.
Layout Viewports.
Layout Templates.
Work With Layout Tabs.
Create a New Layout Viewport.
. Layout Wizard.
. Page Setup Manager.
. Commands for Working with Layouts.
. Describe EXPORTLAYOUT command.
. Describe LAYOUT command.
. Describe LAYOUTWIZARD command.
. Describe MODEL command.
. Describe MSPACE command.
. Describe MVIEW command.
. Describe PAGESETUP command.
. Describe PLOT command.
. Describe PSETUPIN command.
. Describe PSPACE command.
. Describe VPCLIP command.
. Describe VPLAYER command.
. Describe VPMAX command.
. Describe VPMIN command.
. Describe VPORTS command.
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Appendix 1

Tasks for self-study

You have to do the following:

. Creating a drawing, the drawing should be read by AutoCAD 2008.
. Drawing walls with the POLYLINE command.

. Drawing windows and doors.

. Drawing stairs.

. Drawing of sanitary equipment.

. Drawing furniture.

. Drawing sizes.
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